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LAST MINUTE MACS

JUST AS | was putting this issue of
MaclLife to bed, satisfied with the way it
was looking, at the last minute Apple
goes ahead and announces new products
due to be launched just a day later.
Interestingly, back when we were a
print—first title, this would have been a
non-issue. Even if my publisher would
have allowed me an extension on my
deadline, the news would have still been
massively out of date by the time it hit
the shelves, compared with news sites
online, that is. But now that we’re a
digital-only title, things are a little bit
easier. Getting an extension is
straightforward, as there is no valuable
print slot to carefully manage, and it means that when Mac|Life
does go on sale just a week later after it’s been put to bed, the
content is much more timely. Naturally, we’re never going to
trouble online news outlets which are able to get the content out
there within minutes of it being announced, but then again
they’re never going to trouble the high—quality, carefully curated
nature of magazines. So there. Plus, I figure that a decent number
of people reading magazines are a little more relaxed about
what’s going on in life, and probably aren’t desperate to have the
latest Apple news instantly beamed to their iPhones.

Going back to that last—-minute event from Apple, then. Not
surprisingly, given the details had already been leaked by Apple
insider Mark Gurman, a new, “scary fast” M3 chip was revealed,
in various guises, and along with it an updated MacBook Pro
(14— and 16-inch), and (finally!) an updated iMac (24-inch). We
still don’t know exactly why Apple skipped the iMac with the M2
chip, though. The new Macs are available now, and you can find
out more about them in our Start section on page 4.

On another note, a few weeks ago we combined forces with our
sister title iMore for our newsletter updates. If you’re already
subscribed, this means you’ll get the weekly iMore newsletter
sent to your inbox, plus a bi-monthly one from yours truly. If
you’re not yet subscribed, head to page 79 to do so. Scan the QR
code to be taken to the sign up page. It’s worth it! m

Wik

NICK ODANTZIS, Editor

Twitter: @maclife

EMAIL: letters@maclife.com
SHARE YOUR THOUGHTS FACEBOOK: facebook.com/maclife
TWITTER: twitter.com/maclife

Editor's opinion
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Andrew Cottle

Art Editor

Andrew is intrigued to read
how Apple is facing climate
challenges, and happy that it's
determined to advance in an
ecologically sounder way (p6).

Rachel Terzian

Production Editor

Rachel is having fun in i0S 17
creating Stickers from photos,
then sticking them to other
photos to create “artistic” (in
her view, anyway) collages.

Carrie Marshall
Contributor

Not yet tempted by a new
Apple Watch? Carrie’s guide to
all the new features in the
latest watchOS 10 might just
change your mind (p41).
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New Macs with M3 chips

Next-gen Apple silicon arrives in laptops and iMac

BY ALEX SUMMERSBY

APPLE HAS INTRODUCED a new
MacBook Pro lineup, plus a new
24~-inch iMac, all powered by a new
generation of Apple silicon.

Apple says the 14-inch MacBook Pro
with M3 chip is up to 60% faster than
the 13-inch model with M1, and it now
starts at $1,599 — S$400 less than
before. The 16—-inch MacBook Pro with
M3 Pro and M3 Max still starts at
$2,499. The M3 Max model is up to 11x
faster than the fastest Intel-based
MacBook Pro, Apple says.
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Models with M3 Max support up to
128GB of unified memory, and the
range is configurable with up to 8TB of
storage. M3 Pro and M3 Max models
also now come in Space Black, a new
dark aluminum finish.

All MacBook Pro models feature a
Liquid Retina XDR display with 1,000
nits sustained and 1,600 nits peak
brightness for HDR content. SDR
content is now displayed at up to 600
nits, which is 20% brighter than
before. All models have a built-in

aSTART

1080p camera, and an immersive six—
speaker sound system. The power
efficiency of Apple silicon means that,
unlike PC laptops, the MacBook Pro
lineup deliver the same performance
whether plugged in or on battery, with
up to a huge 22 hours of battery life.

NEW iMAC WITH M3

The new 24-inch iMac with M3 chip
starts at $1,299 and is up to 2x faster
than the previous generation with M1,
Apple says, and is 4x faster than the



most powerful 21.5-inch model with
Intel chip.

The new iMac has a
“best-in-class” 1080p FaceTime
camera, studio—quality mics, and
six—speaker sound system with
support for Spatial Audio. The
24-inch 4.5K Retina display has 11.3
million pixels, P3 wide color gamut,
and 500 nits brightness. The M3
chip inside has an 8—core CPU, up to
a 10—core GPU, and support for up to
24GB of unified memory.

The new model has faster wireless
connectivity, with Wi-Fi 6E, which
delivers download speeds up to
twice as fast as the previous
generation, and Bluetooth 5.3, for
connecting to the latest Bluetooth
accessories.

MEET THE M3

The M3 family are the first personal
computer chips manufactured
using the industry-leading 3-
nanometer process. This means
more transistors can be packed into
a smaller space, improving speed
and efficiency. M3 has 25 billion
transistors — 5 billion more than
M2. M3 Pro has 37 billion
transistors and an 18—core GPU,
while M3 Max has 92 billion
transistors, two ProRes engines,
and a 40—core GPU that is up to 50%
faster than M1 Max.

The CPU performance cores are
30% faster and efficiency cores 50%
faster than those in M1, and the
Neural Engine 60% faster. Plus,
using a new technology called
Dynamic Caching, the GPU allocates
the use of memory for each task in
hardware in real time, serving to
dramatically increase GPU
performance for the most
demanding pro apps and games.

The M3 chips also bring new
rendering features such as
hardware—-accelerated ray tracing
and mesh shading to Mac for the

first time. Rendering speeds are now

up to 2.5x faster than on the M1
family of chips. Plus, a new media
engine includes support for AV1
decode, providing more efficient
and high-quality video experiences
from streaming services.

News in
brief

> APPLE PENCIL (USB-C)

Apple has added a new Apple Pencil to
the range, giving users three to choose
from. With “pixel-perfect accuracy,” low
latency, and tilt sensitivity, the new
Pencil is compatible with all iPad models
that have a USB-C port, including iPad
Pro, iPad Air, and iPad mini. At $79,
compared to $129 for the 2nd-gen
Apple Pencil, the new USB-C model is
more affordable, but it is not pressure-
sensitive, does not charge wirelessly,
and does not have the 2nd-gen’s
double-tap to change tools feature.

> ELGATO PROMPTER

Want to add that professional touch to
your recordings, streams, and YouTube
videos? Professional teleprompters help
you connect with your audience with
natural eye contact but typically cost
thousands of dollars. The Elgato
Prompter is a new $280 all-in-one
device that's compatible with most
cameras, webcams, and iPhones. It
connects to your Mac over USB-C and
includes a 9-inch monitor that can
display any app. file, or browser you
choose, so you can read your script
while still looking at the viewer.
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'Mac|Lifes®

wVESTIGATES
Apple's green
credential

Apple likes to emphasize the work it does to protect

the environment, but how robust are its green
credentials? BY CHARLOTTE HENRY

I— —I t’s October 2020, and while
I almost all of us are dealing
with some form of
L_ lockdown or COVID-19
restriction, Lisa Jackson is on the roof
of Apple Park. It is that year’s crucial
iPhone keynote address, and Apple’s
vice president of environment, policy
and social initiatives is explaining
how, by 2030, “we plan to have Net
Zero climate impact across our entire
business.” She points out previous
environmental progress the firm has
made and announces new
developments, for instance that the
magnets in the iPhone 12 use 100%
recycled rare earth elements. Oh, and
EarPods headphones and power
adapters are no longer going to be
included in the box with a new iPhone,
helping to reduce packaging,
materials required, and carbon
emissions. Apple had long talked
about its environmental concerns, but
for many that was the moment the
commitment became clear. The
company was literally shouting about
it from the rooftops!
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Jackson’s appointment to her role is
an important element in the story.
She joined Apple in 2013, having
previously served as administrator of
the US Environmental Protection
Agency (EPA) under president Barack
Obama. She reports directly to CEO
Tim Cook, underlining the value he
puts on her work. Indeed, he
announced the hire himself at the
AllThingsD conference in May 2013.
Part of the conversation focused on
Apple’s environmental initiatives, and
he used the opportunity to tell the
audience: “Lisa Jackson is joining
Apple. Lisa was running the EPA for
the last four years. She’s going to be
coordinating a lot of this activity
across the company.”

He added that Jackson, a trained
chemical engineer, would “fit right in
with our culture.” Arguably, she has
not just fitted into company culture
but helped shaped it. Jackson now
regularly speaks during Apple keynote
events, explaining the latest
environmental steps being taken in
Cupertino and beyond.

As said, those goals all lead to Apple
being Net Zero by the end of the
decade. This is not just about what
happens at company HQ or even its
factories. The intention is that Apple
will be carbon neutral across its
business, supply chain and product
life cycle. It is a huge undertaking
requiring the involvement of
numerous third parties.

SUSTAINABLE STEPS

Cut to September 2023. Octavia
Spencer is in the Apple boardroom.
The Oscar-winning actor and star of
the Apple TV+ series Truth Be Told is
playing Mother Nature. She is
demanding an update on
environmental initiatives from top
Apple execs. Cook is there, as is

Image rights: Apple Inc



Jackson, helping to emphasize how
important this all is to their firm.
Among other things, Mother Nature is
told that all plastic will be gone from
Apple packaging by the end of the
year, about the use of recyclable
aluminum in various products, and
that all Apple offices, stores and data
centers run on clean electricity. The
skit goes on for over five minutes. It’s
a bit cheesy, but it allows Apple to
reiterate once again its dedication to
being green.

Away from keynote addresses, the
company releases an Environmental
Progress report every year. Its 2022
report boasted: “In fiscal year 2021,

our environmental initiatives avoided
over 23 million metric tons of
emissions across all scopes, and we
reduced our carbon footprint by 40%
compared with fiscal year 2015. Efforts
and initiatives that we’ve been
growing for years made this possible
— like sourcing 100% renewable
electricity for our facilities,
transitioning suppliers to clean
energy, and using low-carbon
materials in products.”

Looking at the supply chain, the
document said that 213 suppliers had
“committed to renewable electricity
for Apple production”. Itis a

somewhat vague statement, but it
nonetheless highlights the
considerable power and influence
Apple has over other firms. Apple is in
control of not just its own
environmental practices, but those of
other companies who don’t want their
(lack of) green credentials to mean
that a lucrative deal with Cupertino
comes to an end.

Many of us trade in our old Apple kit
when we want a new one. It helps
reduce the cost. But what happens to
those discarded devices? Well, they
get to meet Daisy. Introduced in 2018,
Daisy is a robot that can dismantle
iPhones. Up 1.2 million of them a year,
in fact. The valuable materials are
then recycled. In that 2022 report, =
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Apple announced that it was utilizing
certified recycled gold. Furthermore,
it said it was using more than twice
the amount of recycled tungsten, rare
earth elements and cobalt as it had
previously. This all meant that in
2021, 20% of all material used in its
products contained recycled material.
Lately, Apple has also removed
leather from its own line of iPhone
cases in a further bid to reduce carbon
emissions, replacing them with the
FineWoven range. (The Apple Store
description also points out that the
cases are made from “68% post—
consumer recycled content”.) There
are also FineWoven Apple Watch
straps. However, there are still leather
iPhone cases and Apple Watch straps

Apple assures that by 2030, all its devices will have
a net zero climate impact.

The company uses 100% recycled cobalt in the
battery of the Watch Series 9 and Ultra 2.
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available from third parties; Apple
can’t control everything.

NOT EASY BEING GREEN
In general, then, things are positive.
Apple is making serious progress in its
goals to make itself and those it works
with greener. But is it that simple? Is
Apple, a worldwide tech giant that
hovers around a market cap of $3
trillion, all that bothered about the
environment? Doesn’t it just want to
make more gadgets so that we all buy
more gadgets, and the company
makes more money? Ultimately, isn’t
this merely a PR exercise? Isn’t it...
greenwashing?

The University of Pennsylvania
Center for Science, Sustainability and

Apple's recycling robot Daisy [left] disassembles
iPhone devices to enable recovery of its valuable
materials, whereas the Taz machine [below]

recycles modules containing rare earth magnets.

the Media were certainly unimpressed
by the “Mother Nature” video.
Academics Joseph Romm and Auden
Schendler, in an article originally for
The Messenger but republished by the
institution, said that the clip
“represents monumental
greenwashing. Worse, the company’s
dubious carbon-neutral claims may
even set the company up for a
potential lawsuit. And Apple is not
alone: rival Microsoft — and many
other companies — are playing
similar games.”

They noted that the company had
declared the latest Apple Watch “its
first carbon-neutral products”.
However, Apple has decided this
means that it has achieved “at least a

All Apple Watch cases since Series 5 have used
100% recycled aluminum.

e

Apple also has a goal to be plastic-free
in its packaging by 2025.

Image rights: Apple Inc.



75% reduction in product emissions
for each model”. The remaining 25%
is covered by “high—quality carbon
credits,” but there is growing legal
wrangling in this area.

WHAT ABOUT PRODUCT LIFESPAN?
There is also the hotly disputed issue
of so—called planned obsolescence

— the idea that Apple deliberately
designs its products to have a limited
lifespan so that customers need to
replace them. This would undoubtedly
be terrible for the environment and
the company’s green credentials,
although good for its profits.

Back in 2021, ZDNet writer Adrian
Kingsley-Hughes alleged: “Apple is
actively working to curtail the lifespan
of products by making them unduly
hard to repair, charging uneconomical
repair prices, and locking out third
parties from being able to offer more
reasonable repairs.”

Apple categorically denies that
planned obsolescence happens. It
could point to the improved durability
of its products: the iPhone 15 Pro is
made from titanium, for instance. It
would also likely highlight its
increasing (albeit slow) embrace of
the right to repair, whereby
consumers can fix their own devices
instead of having to send them away
to specialists or buy new ones. This all
leads to a longer lifecycle for devices.

LEADING FROM THE TOP

There can be little doubt that people at
the top of Apple really do care about
the environment and are legitimately
trying to limit the damage done to it
by the company they run. In his
biography of Tim Cook, author
Leander Kahney recalls how the CEO
told conservative investors
complaining about a potential hit to

APPLE IS MAKING
SERIOUS PROGRESS
TOWARDS ITS
GOALS.. BUT IS

IT THAT SIMPLE?

Image rights: Apple Inc

the bottom-line from environmental
initiatives: “If you want me to do
things only for ROI reasons, you
should get out of this stock.” A bold
statement indeed from a company
leader. The book also reports that
Cook told Lisa Jackson that he wanted
to “leave the world a better place than
we found it.”

There is praise in there too from
Gary Cook, then a senior figure at
environmental charity Greenpeace.
He said that “Tim Cook thinks it’s
important. He has been quite
outspoken on the need for climate
change.” He also noted the
significance of hiring Jackson.

Cook has without doubt shown
more interest in environmental
initiatives than his predecessor Steve
Jobs ever did. However, his record is
not perfect. In that biography, Kahney
recalls an incident in 1998 in which
Cook appears to have allowed “tens of
thousands of unsold Macs” to end up
in landfill as a way to reduce the
inventory that was on the company’s
balance sheet. Not very green...

ABETTER FUTURE?

Overall, it seems fair to say that under
Tim Cook, Apple has made genuine
progress on reducing the negative
impact that the company and its
products have on the environment.
Hiring individuals like Lisa Jackson,
with the credentials she has,
undoubtedly demonstrated a serious
commitment to the cause.

The latest news from the world of Apple

Grid Forecast
Cupertino

A new tool in the Home app, Grid Forecast, aims to
help users consider their electricity usage.

Yet it is also undeniable that
regularly talking about the
environment is a good marketing
exercise. It boosts the Apple brand in
the same way consistently stating its
commitment to privacy does. It makes
us feel good about buying its products.

We as consumers and fans of Apple
have to keep things in perspective.
The company is not perfect. That
probably is not even possible. But we
need to ask ourselves, even if there is
some greenwashing going on, would
we rather that than the company
doing nothing at all? &

~ By

‘Apple’s “Mother Nature” sketch serve
steps the company has been taking towards its environmental targets.
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> THE SHIFT

MATT BOLTON is worried that Apple’'s Neural
chips are bringing back software class
divisions we'd nearly left behind

NE OF THE benefits of Apple
producing its own chips, and
of a general plateauing of
Intel chip improvements in
Macs even before the Apple switch,
over the last few years has been
that we didn’t get much of a “left
behind” syndrome when new OS
updates were released. In the days
of OS X, it wasn’t uncommon for
some of the new features of an
update to be locked away if your
Mac was too old. But we got to a
point where that wasn’t so much of
an issue, and effectively any
new feature coming to Mac or
iPhone especially would be
available on anything the software
runs on.

FEATURES BASED ON
MACHINE-LEARNING
TECHNIQUES REQUIRE
APPLE'S NEURAL CHIPS

If I had just bought Apple’s most premium headphones,
and they didn't get the latest features, I'd be very unhappy.

The “left behind” syndrome
didn’t totally go away (on iPad, it
really reared its head recently with
Stage Manager, which only works
on specific machines with heftier
processors), but for most of us, the
fear of our devices being missed off
the list of cool upgrades is rare
now. But it’s growing again in
2023, and it seems to come down to
the rise of features based on
machine-learning techniques that
require Neural chips. There are two
obvious examples from this year of
new “features” that are all about
software, but aren’t available
on older models because their
processors aren’t up to it.

The first is the Adaptive Audio
features that just arrived on
AirPods Pro 2. These create a
new kind of Transparency
mode that more selectively
blends the outside world with
what you’re hearing, and can
automatically switch modes
when you talk to someone, so
you can hear the response.
Evidently, it requires the power

of the H2 chip, which is only used
in the second-gen AirPods Pro
right now. That’s a big shame for
owners of the first—gen AirPods
Pro, but it’s even more frustrating
for anyone who recently bought
AirPods Max — Apple’s most
expensive and premium
headphones, still on sale right
now, and lacking support for these
latest features.

The second is the new “double
tap” gesture introduced on the
Apple Watch Series 9, which is

The new “double tap” gesture would be a
great upgrade for existing Apple Watch users,
but it's on Series 9 only.

detected using heart and motion
sensors that are the same as on
Apple Watch Series 8 (and 7), but
seem to need the new Neural chip
to accurately interpret them... even
though a version of this feature

has been available on Apple Watch
for a while, among the Accessibility
options. And while we’re talking
about Apple Watch, let’s also
mention the new on-device Siri
speech understanding, which

again is available on the new

model solely because of its

Neural comprehension power.

All of these are very useful
features. Neither requires new
dedicated hardware such as sensors
or mics to make them happen —
it’s about the speed to run them
to Apple’s satisfaction. We’re
entering a world of very interesting
software possibilities with the rise
of machine-learning tools and the
hardware to run them in every
device, but I don’t love that
it’s bringing back a two-tier
system of software, with divisions
even between devices being
sold today.

>>> Matt is Managing Editor at Future's flagship technology website TechRadar and has been charting changes at Apple since
his student days. He's skeptical of tech industry hyperbole, but still gets warm and fuzzy on hearing “one more thing".
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LETTER OF THE MONTH

I am looking for a “packing” list
rather than a To-Do app. The
Palm PDA had an app that had
three views: the total list of items
to consider, the list (view) of
checked items, and a list of
unchecked items. This list could
be reset to uncheck the (checked)
items so that the list could be used
to repeat the actions needed. The
reusable list was a simple listing
of items (actions, for example),
was easy to use while packing, and
was easy to maintain.

Most To—Do lists are intended
to be a reminder of some to—-do
action. Once completed, the
To—Do app wants to delete the
checked item or to file the item
out of sight. The list is not
instantly reusable.

Do you have any suggestions on
an app that is similar to the Palm
PDA reusable list?

CHARLES JENNINGS

Charles — we’ve not featured a
packing list—type app for some
while now, but fear not: we’ve got a

very good alternative to suggest,
and best of all it’s completely free.
The Reminders app already on your
iPhone is a great alternative to apps
that are purpose built for such a
task. And as far as we’re aware, it
can do everything you need it to.

By creating a list in Reminders,
you can add items to it which can
then be checked off, and most
importantly recovered at a later
date to re—use the list. The app will
allow you to display checked and
unchecked items, and will also
show the number of items that
you’ve completed (though for some
reason it doesn’t show you the total
number of items remaining).

You can also create sections in
order to group similar items
together, such as food or clothing.
Plus, you can share lists with other
people you know, enabling two or
more people to collaborate on a
packing list — very useful for
couples or families.

If you know of a better way to
create a packing list, then do get in
touch with us.

Baby Care

Beverages
Medication

Household Items

Tissues

Personal Care & Health

Staying alive

In the August issue the

article on reviving old Macs
was great! | have been a fan of
keeping them going since my
first PowerBook. | just got a
2012 MacBook Pro to run
Ventura, no problem with
OpenCorel! It seems to be
running great, and I've already
tested it with Zoom. Now |
have to decide if | want to try
Linux Mint on the 2010
MacBook | still have..

JEFF KIDMAN

Ah, there’s nothing better
than keeping an older

SHARE WITH US!

machine running —
especially when there’'s
nothing wrong with it, apart
from the hardware being a
little out of date. About six
years back we were still
running the MacBook Pro
(Retina, 13-inch, Late 2012)
in the Mac|Life offices, and it
was a thing of beauty; never
had any issues. It was the
perfect size for throwingin a
bag too. We're now on the
MacBook Pro (16-inch, 2019)
which is a bit of a beast by
comparison and often chugs
under the load of many
publishing applications.

EMAIL: letters@maclife.com

We've no doubt we'll be
moving to Apple silicon soon
enough, which should see
an improvement in speed
and cooling.

Easy printing

In response to the letter from
Mike Kennedy in the October
issue (Mac|Life #211), yes there
is a way to print — | selected,
copied and pasted the
guestion and your response in
the app to this email, just to
show it could easily be done. |
could have pasted this text
into Pages or Word to size and
print. The only negative to this

FACEBOOK: facebook.com/maclife TWITTER: twitter.com/maclife

way is that it only works with
text — embedded pictures and
graphics don't come along in
the process.

LEN CARMICHAEL

Thanks Lee, that's a good bit
of advice. Copying and
pasting text works easy with
that way, if a little on the
laborious side (and as you
say it only works with plain
text, but not with images or
page layouts). The method
we suggested is pretty
quick when you consider
you get the whole magazine
page to print.

Mac|Lifes*
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What exciting new features does the latest relse
of the Mac's operating system have in store for us?
It's time to take a look at macOS 14: Sonoma

WRITTEN BY IAN OSBORNE

NCE AGAIN, A new version of
the Mac’s operating system,
macO0S, arrived in the fall packed
with useful new features and
enhanced capabilities.

Sonoma takes a fresh look at screen
savers and adds widgets to the desktop.
New video conferencing features let you
place your own image on top of your
presentation, and Game Mode enables your

For the last decade, Apple has named games to run better by giving priority to
each new version of macOS after a the CPU and GPU. In Safari, you can divide
Californian landmark, and this year’s release your browsing between Profiles, and save
—macO0S 14 — is no exception. mac0S out web pages as Dock applications. In
Sonoma takes its name from a city in the Reminders, your tasks can be displayed
North Bay region of San Francisco Bay. Wes as a kanban board and you can share
Craven'’s Scream was partly filmed there, AirTags and accessories with up to
but the new version of macOS is certainly no five other people in Find My. It's all in the
horror story. amazing macOS Sonoma.

mac0S Sonoma works with...

As you'd expect, macOS
Sonoma drops support for
some older Macs. If you're
running macOS Ventura
on a 2017 MacBook Pro,
a2017iMac or a 2017 12-
inch MacBook, you
can'tupgrade to Sonoma.
Unfortunately, some
features in Sonoma are
for Apple silicon Macs

12  DEC 2023

only, and cannot be used
on Intel Macs running
Sonoma. These include
Presenter Overlay, the
abbreviated wake word
“Siri” (instead of “Hey
Siri”), and Game Mode.
To run macOS Sonoma,
your Mac must meet the
following system
requirements...

Desktop Macs

+ iMac: 2019 and later

¢ iMac Pro: 2017

+ Mac Pro: 2019 and later

+ Mac Studio: 2022 and later
+ Mac mini: 2018 and later

Notebook Macs

+ MacBook Air: 2018 and later
+ MacBook Pro: 2018 and later

Image rights: Apple Inc.
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In mac0S Senoma, widgets can be taken out of the Notification Center
and placed on the desktop. When you're doing something else on your

’ j Mac, they.fade into the background to avoid distractions.

Desktop & screen savers

THE WAY YOUR Mac uses anywhere on the desktop. You can then Finder windows are then pushed to the
widgets has had a very review the information they offer ata glance. | edges of the screen, just like they are when
. a welcome overhaul. In previous So they don't distract, when you open an you do a four-finger spread gesture on

- = versions of macQOS, you had to app on your Mac, the widgets blend into the a trackpad. Your widgets are then easy to
open the Notification Center by clicking on background, intelligently lifting color from see. Naturally, clicking on a widget (whether
the time and date in the menu bar. In macOS the wallpaper behind them. It's easy to get it's diminished or not) opens its parent app.
Sonoma, you can drag them out of the back to the widgets. All you have to do is And thanks to Continuity, widgets from your
Notification Center and place them click on the desktop, and application and iPhone are also available on your Mac.

! Screen savers

& wallpapers

macOS Sonoma features When you wake your Mac
some gorgeous slow-motion ready to unlock it with your
video screen savers of places password or biometrics, the time
around the world. Look out and account photo stay out of
for the Hong Kong skyline, the way so they don't detract
Monument Valley's sandstone from the screen saver. After
buttes and, of course, the logging in, the screen saver
hills and valleys of Sonoma, stops moving and becomes

— — the Californian territory that your desktop image. They look

Apple’s new screen savers feature slow-motion video scenes from 93"9 USCRIELIE S great, SNEIENTE 'your lacenell

its name. in-one aesthetic.

around the world. Here we see Sonoma, California.

14 DEC 2023 Image rights: Apple Inc.



HOW TO Add widgets to your desktop

/I Choose a widget

To add widgets to your desktop from
the Notification Center, click the time and
date display in the menu bar to open it,
then simply drag a widget onto the
desktop. You can drag it back again too
if you change your mind.

Use and interact

You can drag widgets around the
desktop, and click on one to open its parent
app. Here we clicked on Clock. Widgets are
interactive, so you can use them to
operate their parent apps without having to
open them.

2 Check out the gallery

Alternatively, you can Ctrl-click on the

desktop and, from the contextual menu,

select Edit Widgets. A Widget Gallery
appears, from which you can add widgets
to your desktop, or to the Notification
Center if you prefer.

Lk |

Access from iPhone

Thanks to Continuity, you also have
access to widgets from your iPhone in
macOS Sonoma. Just make sure your
phone is nearby or on the same network.
Like all widgets, choose a size that's best
suited to your needs.

HOW TO Do more with screen savers

Choose a screen saver

In the Apple menu (top-left corner of
desktop), select System Settings. In the
left-hand sidebar, choose Screen Saver.
Scroll the right-hand window up and down
to see what screen saver options are
available on your Mac.

Image rights: Apple Inc.

Slow-mo videos

Slow-mo video screen savers include
landscapes, cityscapes, underwater scenes
and images of the Earth. Click on one to
choose it. Choose one, and if it doesn't
download automatically, click the
Download button.

Sonoma Superguide

3 Organize widgets

Drag widgets from the Widget Gallery
to the desktop, and place them where you
like. To drag a widget into the Notification
Center, click the time and date display to
open it (everything moves to accommodate
it) then drag it in.

é Deleting widgets

You can drag widgets around the
desktop — just click on one and drag it into
a new space. To delete a widget, open the
Widget Gallery and click on the “~" sign in its
top-left corner to remove it. You can
always add it again later.

Set as wallpaper

To use the screen saver as a
desktop wallpaper, click the switch.
If you want to change your wallpaper
to something other than the new screen
savers, in System Settings, click on
Wallpaper in the sidebar.

DEC 2023 | 15
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Messages

The Mac’s messaging app gets a few new features

Stickers

The application drawer has been
tidied up, with all stickers found in
one window. Click the “A” icon to
the left of the text input field for a
menu of things you can add to a
message. Select Stickers fora
pop-up sticker picker. This has
three tabs: the clock face tab
shows recently used stickers; the
middle tab depicting a peeling
sticker shows all your stickers,
including those made on your
Apple mobile devices; and the
last tab is Memoji stickers.

You'll find stickers are much more
accessible in mac0S Sonoma.

16 | DEC 2023

In Sonoma’s Messages app, you can combine
search filters to narrow down your searches.

INSONOMA, THE Messages
app is now easier to search. In
common with i0S and iPad0S
17's Messages apps, you can
use search filters to narrow down your
results and zoom in on what you're looking
for. After typing a search term, you can then
add additional terms. Search filters can be
names, files, locations, web addresses and
more. When you begin to type a name, for
example, completion suggestions are
offered in a menu. Choose one, and
it becomes a search filter. Choose Link,
Location or Photo from the menu that
follows, and you can search for pictures,

[llllll!lHl “lll"llllm LUBT 4 o o e
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Audio messages are now transcribed and offered
in text so you can read it as well as play it.

web addresses or places associated
with that Messages chat.

If you've not checked a group chat for a
while, an up-pointing chevron icon in the
top right lets you zoom to the
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A& oldest message you've not read.
In group or individual chats, you
can reply to an individual
message in the conversation by
two-fingered swiping it to the
right, though this only works
with iMessages, sent through
Apple. Incoming audio
messages are now

transcribed too. You can still
click the Play icon to listen to

Swipe a message to the right, and you can reply to it directly,

as long as it was sent as an iMessage.

them, but their contentis
also offered as text.

Image rights: Apple Inc.



Video conferencing

macO0S Sonoma brings us some great new ways to present remotely

SINCE THE PANDEMIC and
ng resultant lockdown, video chat
BB has become more widely used
on all platforms. To make video
communication even better, macOS
Sonoma brings Presenter Overlay to Apple
silicon Macs, a new feature that can be used
with any video conferencing app, not just
FaceTime. If you're sharing content such as

your desktop or a slideshow, you can use
Presenter Overlay to impose your image on
top of whatever it is you're showing, so the
people you're presenting to get to see you as
well as your presentation. This is especially
useful for business chats.

For more casual video conversation,
there are Reactions (Apple silicon Macs
only). These let you trigger graphical displays

Use Presenter Overlay (Apple silicon Macs only)

- il ..
iy
99 MILES T
FESTIVAL

1 While sharing your screen or a
presentation in a video conference, click on
the icon showing a screen and a silhouette
in the menu bar. You see this menu. As you
can see, Presenter Overlay can be Off,
Small or Large.

4 Large Presenter Overlay uses the
Neural Engine to take the image from your
webcam, separate you from

the background, and place your screen

in between the two, with your picture

in front of your content.

Image rights: Apple Inc.
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with hand gestures. Make a

peace sign and the screen is

filled with balloons. Two thumbs

up gives a fireworks display, making
a heart shape with your fingers
throws up lots of heart icons, and
more. If hand gestures aren't your
thing, these Reactions can

be triggered using a menu too.
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2 If you select Small in the Presenter
Overlay section, you appear in a small
bubble that can be dragged around the
screen and placed wherever you like.
This image is, of course, taken from
your own webcam.

_. LT
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5 The webcam continues to pick up
your movement, enabling you to move
around in front of your presentation, while
the background remains behind it all.
Naturally, you can talk to your viewers too,
as usual.

3 The Large option in Presenter Overlay
gives you a greater prominence. You're to
the fore, with your presentation being
placed between yourself and the
background. Again, this information is
supplied by your webcam.

o,
' .

A

\

w 5,

é You can use Reactions in a video
chat, either choosing from the menu as
shown, or by giving a gesture. You can use
these new effects with a large range of
video chat apps, such as FaceTime, Zoom,
Teams, Webex and more.
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@ Feature

Safari

Do more with the Mac’s

web browser

NO NEW VERSION of macOS
would be complete without

some new Safari features and
improvements, and of course

Sonoma is no exception. According to Apple,

in macOS Sonoma, Safariis the world's
fastest web browser.

Private Browsing gets a significant
update in Sonoma, helping you keep your
web surfing even more private when needs
must. You'll now find that trackers are
automatically blocked, and that Private
Browsing windows are helpfully locked
when you'e not using them.

New Safari Profiles let you divide your browsing into categories such as Work, Home and more.

To further streamline your general Safari
use, you can use Profiles to separate your
browsing into user-defined categories. You
can have one for websites associated with
work, one for personal browsing, one for a
specific hobby or subject you enjoy, and so
on. The Profiles feature not only keeps your

Enhanced Private Browsmg

Safari now locks Private Browsing
windows when you're not at your Mac,
SO No one can see what you were
looking at. You can lock them manually
using Window > Lock All Private
Windows, or Cmd+Ctrl+L. Known
trackers are blocked from loading, and
trackers that are added to web
addresses as you browse are
automatically removed.

bookmarks separate, but also
compartmentalizes your cookies, history,
extensions, Tab Groups and Favorites, so
you can set up each browsing experience as
you choose. If you use a site for both work
and personal use with separate login
accounts, you can sign in to them separately
and switch between them quickly.

To use Safari Profiles, open Safariand in
its application menu, choose Settings. Click
the Profiles tab, and add or remove profiles
using the “+"and "="icons in the bottom-
left corner. When set up, you can switch
between profiles using a pull-down menu in
the browser’s toolbar.

Perhaps the most useful update to Safari
is the ability to make web apps out of
websites. They're saved to the Dock and the
Applications folder, and function like regular
apps. If you've ever explored a website and
wished it was available as an app instead,
this feature is for you.

E GLOBAL: =%
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fl First steps

To start, launch Safari and open the
page you want to turninto a fully
functioning web app. In Safari's File menu,
select the option titled “Add to Dock” as
shown above — you will find it towards the
bottom of the menu.

18 | DEC 2023
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Name the app

A window appears in the middle of the
screen. Edit the name of the website (which
will be the name of the web app) and its
web address if you wish. Choose something
short for the name. When you're ready, click
the Add button.
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In the Dock

Close the Safari browser window.
Your web app can now be found in the
Dock, with your other apps. Simply click on
it to open the web app, which now
functions independently of Safari, with a
simplified set of controls.

Image rights: Apple Inc.



Privacy & Security

COMMUNICATION SAFETY
IS a useful feature for parents
to use for helping prevent their
.. children from seeing
somethmg they shouldn't. It's accessed
through Apple menu > System Settings >
Screen Time. Click on Communication
Safety, and you can turn on the “Check for
Sensitive Photos” option for your children’s
devices. In the Messages app, this feature
checks for nudity and provides them with
guidance and age-appropriate resources
should such a picture be sent to them. It
does not give Apple access to these photos.
With Sonoma, Communication Safety
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Sensitive Content Warning is a great way of keeping
nude and vulgar pictures off your Mac.

Set up the Communication Safety feature through
Screen Time. It's a great parental control feature.

also covers AirDrop, the Photos picker,
incoming calls and FaceTime messages,
further reducing the chances of your child
viewing an inappropriate picture.

Another new feature of Sonomais
Sensitive Content Warning, which helps
prevent adult users viewing something
they'd rather not see. Covering AirDrop,
Messages, incoming calls, incoming Contact
Posters and FaceTime video messages, it
warns you that the video or picture might be
sensitive and asks whether you want to see
it. This optional feature can be switched on
or off in Apple menu > System Settings >
Privacy & Security.

Sonoma Superguide

Password
and Passkey
sharing

: A new feature in macOS

w Sonoma lets you share
your passwords and

passkeys with a select group of
friends. After forming a group,
anyone in it can add and edit
passwords and passkeys, keeping
the resource up to date.
You choose what you share —
the group doesn’t simply gain
access to all your password
information — and the group’s
originator can remove a group
member at any time. Sharing is
through iCloud Keychain, so it's
end-to-end encrypted.

You can share passwords and passkeys
with a select group of trusted friends.
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4 Edit web app

Click the web app’s menu and select
Settings, and you can edit the name, web
address and icon used for the app, and
more. Under the Privacy tab, you
can access Privacy & Security Settings and
clear the website data.

Image rights: Apple Inc

5 Launch the app

You can also find your new web app
in the Launchpad (open it from the Dock)
and the Users > [Name] > Applications
folder. Another way of launching it is to use
Spotlight; just open the Spotlight window
and type its name.

“THE GLOBAL =%
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é Delete web apps

You can remove a web app from
your Dock by Ctrl-clicking on its icon
and choosing Options > Keep in Dock.
To delete it completely, in Launchpad,
drag it onto the Trash, then confirm
you want to remove it.
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Son;ma provides a boost to handling PDFs with the Notes app

THE PDF (PORTABLE

DOCUMENT FORMAT) is

a very important type of file,
i @ and one that many of us use

a lot today. The way we work with PDFs

has been enhanced and improved in

macOS Sonoma.

20 | DEC 2023

Using machine learning, text fields in PDF
forms are identified and made available for
typing. You can use AutoFill to quickly fill out
a form, and simply type into fields where no
AutoFillis available.

You can add a signature you have saved
in Preview or make a new one, and check

boxes are ticked when you click on them.
This works on documents you scan with
your iPhone or iPad’s camera and open
on your Mac, as well as those sent to you
asa PDF.

In the Preview app, click the Show
Markup Toolbar button for more options.

Image rights: Apple Inc.
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In Sonoma’s Notes app,
you can begin to type
a note, then move it to
the Pages app where
you can continue.

Sonoma Superguide

Finish
In Pages

7 Ever started typing a
note in the Notes app,
and wished you'd done
itin Pages? In Sonoma, you can
turn a note into a Pages document,
quickly and easily, and with no
copying and pasting required.

In the Notes app’s toolbar, click
the Share icon. From the Share
menu, select Open in Pages and
the Pages app is launched, and the
note you were working onis turned
into a Pages document. Images are
carried across as well as text.

L. We're not sure how sha did it, but we think
et i har bock kg, We'va gol her on the
aut stifl a little wobbly at times

These include a text entry tool, a drawing
tool, a redaction tool, a signature button and
anew text box.

How the Notes app handles PDFs has also
been improved. You can open a PDF stored
within a note at full-width view within the
Notes app, keep multiple PDFs in the same

Image rights: Apple Inc

note, and with Live Collaboration, changes
made to a PDF you're working on with
another person are made in real time.
Another improvement to the Notes app is
that you can now add inline links from one
note to another. With a note open, click on
the place in the note where you want the link
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In mac0S Sonoma, it's much easier to fill
in and send a PDF form on your Mac.

to appear, and Ctrl-click. From the menu,
select Add Link and you can then type or
paste a web address or the title of another of
your notes. You can add a name if you wish.
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Everything else

There's lots more that's new

in macOS Sonoma...

HAVING COVERED THE main
new features of macOS
Sonoma, let’s take a look at
what else it offers. For
example, if you set up Siri to react to
a spoken instruction, on Apple silicon Macs
that instruction can now simply be “Siri", not
“Hey Siri". A useful change, especially if
you've got so into the habit of saying "Hey
Siri” that you say “Hey Alexa” when waking
an Amazon device.

To change the wake instruction for
Apple's personal digital assistant, first open

& Bsaiahis i@

the System Settings app

from the Apple menuin '
the top-left corner of your
screen. In the left-hand
sidebar, click on Siri &
Spotlight. Then, in the
right-hand window, make
sure the Ask Siri switch at
the top is on. Below this switchis a
pull-down menu (the default position
of which is “Off") that lets you turn on
the wake words, so you can summon
Siri with your voice as well as by clicking
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In Sonoma, you can wake the digital assistant with “Hey Siri”
as before, or just “Siri".

on the Siriicon in the top bar. From this
menu, choose “Siri or Hey Siri" if you
want either to wake the digital assistant,
or “Hey Siri" if you prefer to do things the
old way.

By doubling the Bluetooth
sampling rate, Game Mode
greatly reduces latency
when using a PlayStation or
Xbox controller.

$ .

Game Mode & Porting Toolkit

Often when it comes to video games,
the Mac promises much but delivers
little. Every new operating system
seems to have new features to make
the Mac a more attractive platform for
games publishers, but the expected
take-up never appears. With Sonoma,
we have Game Mode to look forward to.
This gives your games priority on the
CPU and GPU, reducing resources
used for background tasks. We're told
this dramatically reduces latency with
wireless accessories like AirPods

and Bluetooth controllers. Game Mode
works with any Mac game, so expect
titles you currently own to enjoy

a boost.

22 DEC 2023

For games developers there's Game
Porting Toolkit, which makes it easier
to port games from other platforms to
the Mac. Evaluating how well a game is
likely to run on a Mac is a process that
used to take months; with the Game
Porting Toolkit, it can be done in
days. Converting the game to the Mac
platform is easier too, significantly
reducing development time.

Yet the game Apple showcased
during the keynote was Hideo Kojima's
Death Stranding, a title that’s new to
the Mac but has been out on other
platforms since 2019. It seems the Mac
is destined to lag behind when it comes
to new games for some time to come.

Kanban
boards in
Reminders

- Akanban board presents
® information in columns, and

pieces of data between them.

board in all but name.

In Reminders, starta new listand in
the View menu, choose As Columns.

Ctri-click or two-finger click on the
main window, and from the menu,

select New Column. You can then add

reminders in the usual way,
Ctrl-clicking on a reminder and
choosing “Move to Column” to
move it between columns.

allows you to move individual

Reminders in Sonoma never uses the
term, but its Column View is a kanban
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The Reminders app now lets you organize lists
in a kanban-like column view.

Image rights: Apple Inc.
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A better People album — now wit pets!

o We all love our pets,
right? They're part

of the family. In mac0S
Sonoma'’s Photos app.,
they're recognized as just that.
Launch Photos and make sure View >
Show Face Names is enabled. Open

a picture with your pet's faceinit,

and click the Infoicon in the

toolbar (the one that looks like a

globe with shining stars). If your pet
has been circled, simply type his or her
name in the space under the ring
around their face. If the face isn't
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circled, click the plus sign in the info
window to produce a circle, drag it over
your pet’s face, and then add the
name. Then, when you close the
Photos app and reopenit, in the People

The Mail app

Not much is new for the Mail
app in Sonoma, but it does

get a couple of fresh and
useful features. One-time verification
codes received in Mail now auto-fill in
Safari, making logins more
streamlined. If you're planning a
holiday or a business trip, Mail pushes
related emails to the top of your
search results as the travel date
approaches. Finally, if you click on
the emojiicon in a new email’s toolbar
(the smiley face), you can add up to
three large emojis in a row. If you add a
fourth, or type anything that shares a
line with an emaoji, they shrink back
down to their regular size.
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Like the Messages app, Mail now lets you
use large emojis in your emails, as long
as there are three or fewer.

Image rights: Apple Inc.

With the Visual Lookup feature, you can
identify plants, animals and even recipes
from the Photos app.

Visual Lookup

Visual Lookup is awesome,
andit's had arevamp. Open a
picture of a plant or animal in

the Photos app. then click on the Info
icon. Click on the icon that appears on
the subject, and it's identified. You can
also use Visual Lookup on food and
have it suggest similar recipes, and it
now works with paused videos as well
as photos. It's an excellent feature for
the curious, or those with aninterestin
wildlife, gardening, cookery or other
such subject that benefits from Apple's
Visual Lookup feature.

& Pets album, you see your furry little
[ ]
Findm
share

friend recognized by name.
AirTags J
Apple’s AirTags are great for
o keeping an eye on your
property. Pop one in your
backpack, suitcase or wallet, and you
can trace its whereabouts using the
Mac's Find My app. In macOS Sonoma,
as well as locating your AirTag, you
can also share that info with up to
five people, so not only you but your
friends and family can also keep an
eye on whereiitis. Give one to a child,
for example, and both parents could
find them should they wander off,

and you could all keep tabs on
communal luggage too.

Share the location of your Apple AirTags with up
to five people in mac0S Sonoma’s Find My app.
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New Accessibility options

THE LATEST MAC operating

system brings a host of new

Accessibility features, with

which you can customize your
computer to make it easier to use should you
have a disability.

For the hard of hearing, devices such as
hearing aids that are certified Made for
iPhone can now be connected to your Mac
for telephone and FaceTime calls, as well as
listening to music or videos. If you find
speaking a challenge, you can use Live
Speech to type whatitis you wanttosayina
call, and have it change the text to speech
for you. If you are at risk of losing the use of
your voice in the future, you can also use
your iPhone or iPad to train Live Speech to
sound just like you do now, and then sync

AirPods

There are a few new features for
Apple’s AirPods, assuming you own a
set that's recent enough to enjoy
them. Updates to Automatic
Switching mean moving between
your Apple devices with your AirPods
is much quicker. This feature is limited
to AirPods (2nd and 3rd gen), AirPods
Pro (st and 2nd gen), and AirPods
Max. Also, when on a call, you can
press the stem of your AirPods to
mute and unmute yourself, assuming
you have AirPods (3rd gen), AirPods
Pro (st and 2nd gen) or AirPods Max
with the latest firmware.

Apple’s own earbuds
enjoy an update, but
the newest features
aren't available on
the oldest AirPods.
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that personal voice with
your Mac.
If you have motor
disabilities, when dictating
and editing text with Voice
Control on your Mac, phonic
suggestions for alternative
words appear. This differs
from when you mistype a
word, and the Mac bases
its suggestions on what
it thought you typed.
With Voice Control, the
suggestions are based on
what it thought you said instead.
Animated images like GIFs can be
automatically paused in Messages and
Safari, and those with vision impairments

We'll soon be able to create collaborative
playlists in the Music app, and work on
them with our friends.

A feature thatisn'tin
n macO0S Sonoma at the time
of writing but is due “later
this year” is collaborative playlists in
the Music app. We've long been able
to share playlists with others, but

with Sonoma (and indeed i0S/iPad0S

17), we can join forces with a few
friends and fully collaborate on one.
Anyone in the group can add new
tracks to the playlist, delete songs
and reorder them in the playlist. You
can react to your friends’ choices

with emoji too. This feature isn’t even

in the beta yet, but we look forward
to seeingit.

With Sonoma's Accessibility features, you can use an alternative
voice in Live Speech, and even train the feature to use your own.

can customize the text size in Mac apps to
suit their preference. These features are
found by opening System Settings from the
Apple menu, and clicking Accessibility in the
left-hand sidebar.

Home activity
history

In Sonoma’s Home app you
Q can now access more info

than before. The app shows
who locked or unlocked a door, and
when they did it. Recent activity for
HomeKit-compatible garage doors,
contact sensors and security
systems are also logged, and
accessible through Home.

To access these new features, you
have to upgrade your Home app to
the new Apple Home architecture.
Open the app. and at the top of the
main window is a notification that
an upgrade is available. Click Learn
More, then Continue. If you missed
this notification, click the “..." icon
(top right), Select Settings and
click Software Update.

Upgrade your connected home to the new Apple
Home architecture to use new features in the app.

Image rights: Apple Inc.



Sonoma Superguide

The Journal app
curates
information from
many other apps
on your Mac to
combine into your
digital scrapbook
and diary.

Later this year, we can all keep our digital jottings and cuttings in one place

A new app coming “later this suggestions of other things to include s0 you will be able to add information
‘ year” helps you curate your gleaned from apps such as Photos, curated from third-party apps as well
memories, taking information Contacts, Maps, Fitness and more. Pictures as Apple's own.
from several different apps you took, people you met, places you visited In typical Apple style, the app is built with
and storing them in a digital scrapbook/diary and workouts you did are all suggested, for privacy in mind. You can lock it when you're

hybrid. Journal is coming to i0S/
iPadOS 17 as well as Sonoma, and
syncs across all three platforms.

Like a diary, Journal lets you write down
your thoughts each day for later review. But

using machine learning, it also makes

you to place in your digital journal for the day.
It's up to you what goes in there — you don't
have to accept every suggestion.

Apple is going to release an API that
allows developers to include Journal
integration into their own applications too,

Other journaling apps

Day One

> Free (IAPs) > dayoneapp.com
This digital diary is built for
reminiscing. It's cross-platform,

available on iPhone, Apple Watch, iPad, and
Mac, with syncing available if you buy a
premium membership. As a free app with a
paid-for tier, it's free to use forever with
unlimited text entries. Custom templates
make journaling easy.

Image rights: Apple Inc.

My Treehole

> Free (IAPs) > Mac App Store
Anather diary-meets-scrapbook;
_# this one's lockable for the sake of

your privacy. My Treehole is free, but with
in-app purchases for premium content such
as more font styles, cloud backup and sync,
Night Mode support, and Touch ID/password
protection. It's a gorgeous way to store your
innermost thoughts.

not using it, so if you hand your unlocked
phone to someone, they can't simply launch
the app and take a sneaky read. And all
processing is done on the device in question,
so nothing is sent to Apple’s servers and
Apple can't read your entries.

Diarly

> Free (IAPs) > diarly.app

The Diarly app is described

as a “private daily bullet
notepad”. It boasts a minimalistic,
uncluttered design that makes it easy to
concentrate on your thoughts. An all-in-one
journaling solution, it has calendar, map and
timeline views and can store images and
photographs too.
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HOW TO DO ANYTHING ON YOUR MAC, iPHONE & iPAD

Master screen sharing

Whether near or far, it's easy to share your Mac's screen with someone else

IT WILL TAKE
30 minutes

YOU WILL LEARN
How to share your
Mac's screen

YOU'LL NEED
macO0S 12 or later
for SharePlay

=

GENIUS TIP

You can't use Screen
Sharing and Remote
Management at the same
time. So, when you enable
Screen Sharing, make sure
Remote Management is off.

28 | DEC 2023

WHATEVER THE REASON, sharing
a screen from one Mac to another
is pretty simple, whether you’re
in the same room or another
continent. You don’t need third-party
software — though there are third—-party
tools that add more features — and you can

HOW TO Share your screen
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Share on a local network

On the Mac whose screen you want to
share, go to System Settings > General > Sharing.
Turn on Screen Sharing. Click the “i" and take a
note of the VNC address. Choose whether to
allow access to all or specific users.

even copy and paste from one Mac to the
other. All the tools you need are built right
into macOS. Screen sharing has been around
for ages, but if you want to share a screen in
FaceTime or Messages using SharePlay,
you’ll need to be running macOS 12 or later.
KENNY HEMPHILL

BITE 4R TLET! PRETIECT 0 =P e

P bt g PP Y QAT

-

Allow more access

Click Computer Settings. If you want
to access the Mac's screen from a PC or
iPad third-party client, click "VNC viewers may..".
If you want to allow anyone to request permission
to view your screen, enable that.

Image rights: Apple Inc.



Start sharing

On the other Mac, open a Finder window,
click Network in the sidebar, click the first Mac
and choose Share Screen. Alternatively, click the
Go menu, choose Connect to Server, and type in
the VNC address you noted.
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Allow sharing

On the Mac whose screen is being shared,

click Accept when the request to share the
screen appears. Then choose Control My Screen
to give the other Mac control, or Observe My
Screen to keep control.

Share with FaceTime

In a FaceTime call, click the camera icon
in the menu bar. Click the Screen Sharing button.
Then, either choose “Share the app window”, and
click on the app window, or “Share the Whole
Screen” and click anywhere.

Image rights: Apple Inc.

How to do anything on your Mac, iPhone & iPad

Screen share remotely

On the Mac you want to share to, invoke
Spotlight, search for “Screen Sharing” and click it
to launch it. In the "Connect to” window that
opens, type the Apple ID to which the other Mac
is logged in, then click Connect.

—— — v —

Manage settings

If you're sharing a bigger screen to a
smaller one, click the Screen Sharing menu, then
Settings. Use the Display tab to set how the larger
screen will scale and “Scroll the screen” to
determine how it will scroll.

| o o — ——

Share with Messages

In Messages, click on a conversation
or send someone a message. Click the “i" and
choose Share. Select either “Invite to Share My
Screen” or “Ask to Share Screen”, depending
on which screen you want to share.

GENIUS TIP

When you share a screen,
your viewing options
depend on your network
connection. Click the View
menu in Screen Sharing to
see your choices.

JARGON BUSTER

SharePlay is a sharing
feature in mac0S and i0S
that allows you to “watch
along” with friends

in FaceTime and Messages,
and can also be used to
share a screen.
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PREVIEW

dupeGuru enables you to place

two photos side by side to
check if they're duplicates or
to compare differences.
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DELTA VALUES ZOOM CONTROLS

Tick this and the file list

will highlight the differences
between a reference file and
potential duplicates.

Use these controls to see your two
chosen photos up close. This makes it
easier to spot any differences.
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FILE DETAILS

This panel provides a more detailed
comparison between your two
selected files in terms of attributes.

Regain drive space with dupeGuru

Remove photos, music and other files from your Mac with dupeGuru

REQUIRES
dupeGuru, mac0S
10.12 or later

YOU WILL LEARN
How to identify duplicate
and similar files, plus delete
unwanted copies

IT WILL TAKE
15 minutes

SEARCH MUSIC
FILES BY TAG,
FROM A
CHOICE OF
TRACK,
ARTIST,
ALBUM, TITLE,
GENRE AND/
OR YEAR
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WHEN IT COMES to keeping your
&‘ drive clean and clutter—free,
ﬁ duplicate files are a huge
contributor to wasted space. But
thanks to a free tool called dupeGuru
(https://dupeguru.voltaicideas.net),
identifying those files and removing them
just got a whole lot easier. The tool doesn’t
just identify exact duplicates, either — it can
also identify any files with the same (or
similar) content.
dupeGuru offers three search modes:
Standard, Music and Picture. Both the
Standard and Music modes can search by
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If an app needs access to any files you're about to delete,
create a Symlink so it's redirected to the retained version.

filename and content, while you can also
include tags in searches for music files,
enabling you to identify tracks stored in
different formats, such as MP3 and FLAC.
Just pick your mode, scan the type and click
Options to refine the search.

You’ll also find universal preferences,
such as the Filter Hardness slider, which
performs “looser” searches to match similar
— but not identical — files, as well as
options related to the specific type of search
you’re performing. For example, you can
search music files by tag, and choose which
ones to include from a choice of track, artist,
album, title, genre and/or year.

FIND SIMILAR IMAGES

In this tutorial, we’re focusing on
dupeGuru’s ability to bring order to your
images. The step—by-step guide opposite
reveals everything you need to know about
scanning your Mac for photos — both exact
duplicates and close matches. This will
enable you to compare multiple attempts to
capture the perfect shot, ensuring that you
only keep the best ones for posterity. Let’s
take a look. NICK PEERS

Image right: Hardcoded Software



How to do anything on your Mac, iPhone & iPad

HOW TO Identify and remove redundant photos

Select scan type

Select Picture under Application
Mode and set the Scan Type to
Contents. Click More Options to set the
Filter Hardness to “95" and tick “Match
pictures of different dimensions” to
match similar (but not identical) photos.
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Scan your drive

Once you have configured your
search parameters, click Scan. A
progress bar will then appear —
depending on the size of the folder(s)
being examined and the speed of the
drives, the scan may take some time.
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Files to remove

If you're happy to remove any
superfluous photos, place a tick next
to them or use the Mark menu to select
multiple files at once. If you'd rather
keep one of the copies, Ctri-click it and
choose “Make Selected into Reference”.

Image right: Hardcoded Software.
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Select folder or drive

Click the “+" button followed by
Add Folder to select a drive or specific
folder to include in your scan. You can
scan a single folder or widen your search
by including other drives and/or folders
in the scan too.

Quick review

Once the scan finishes, a list of
files will appear. Files marked in blue are
the “reference” file that are protected
from being deleted — any files beneath
this are considered matches or exact
duplicates of that file.

Perform cleanup

Once you've highlighted some
files you'd like to remove, click the
Actions dropdown menu where you'll
see options to delete the selected files
to the Recycle bin, or move or copy
them over to another drive.
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Set reference folder

If searching for duplicates, you
may wish to set a “reference folder” —
any photos found inside here will be
deemed the original and are left
untouched by default. Click Normal next
to the folder or subfolder to do so.

Review closely

dupeGuru has several tools that
helps compare your photos and verify if
the matches are either exact duplicates
or close matches. The annotation (see
facing page) reveals how to access
them and what each one does.

Sort many files

If there are too many results to
process in one go, choose File > Save
Results to save your scan results as a
file. When you next open dupeGuru,
select Pictures and click Load Results to
carry on where you left off.
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BEFORE

Add FX to home movies

Add excitement to your films with Adobe Premiere Elements’ FX tools

REQUIRES
Adobe Premiere Elements
2023, mac0S 1 or later

YOU WILL LEARN
How to distort footage, style
color, create composites

IT WILL TAKE
20 minutes

32 | DEC 2023

Add assets

Click the Expert mode tab, then
choose File > Add Media from > Files and
folders. Import your clips and drag them
into the timeline. Click on the “fx" icon,
then click the Video tab. Set the Effect
panel's dropdown menu to Artistic.

_ ONE WAY TO make your home
W] movies stand out is with the

@ addition of eye—catching special
effects, and Premiere Elements
2023 can make this happen with creative
options that will instantly change the look
of your footage.

The video effects are grouped into
sections in the FX panel. We’ll look at
Artistic, Distort and Keying here, but there
are many more effects to explore. Once
you’ve added an effect, you can also modify
its properties as we’ll also demonstrate.

HOW TO Create an animated painting effect

@ EImFEINN

Create effect

icon that has a pencil by it.

Now drag the Mosaic effect onto
a clip in the timeline. This applies the
effect and opens the Applied Effects
viewer. You can also access the Applied
Effects viewer by clicking on the “fx"

We’ll run through how to digitally
distort your clips to create a surreal dream
sequence. You’ll also learn how to make a
video clip look like a living painting, and
even add a zombie to a city street courtesy of
a Hollywood-style green—-screen key.

However, in order to access these special
effects, you’ll need to venture out of the
comfort zone that is Premiere Elements’
Quick and Guided workspaces and head over
to the more powerful Expert editing tab.
We’ll show you how in these steps.
GEORGE CAIRNS
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Adjust intensity

You can adjust the various
properties of an effect in the Applied
Effects viewer. As we'll see later, some
effects have multiple sliders. The Mosaic
effect has a single Intensity slider
— drag it right for a more “painted” look.

Image rights: Adobe.



How to do anything on your Mac, iPhone & iPad

HOW TO Get creative using digital distortions

Lens distortion

As well as changing colors and
tones, you can use effects to displace
pixels for a more stylized look — great
for dream sequences! Go to the Distort
collection and drag the Lens Distortion
effect onto a clip.

SuBEIE N N

Adjust properties Combine effects

In Applied Effects, drag the
Curvature slider to the left to make the
edges of the frame curve towards the
viewer. By dragging the Vertical Prism
FX slider to the left we stretched the
subject’s hair to the right of the frame.

Once you've applied an effect
such as Lens Distortion, you can stylize
the clip further by adding other effect
layers. In our example, we've added in a
Lens Flare effect from the Effects
panel’s Generate category.

HOW TO Produce a green-screen composite

-
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Layer parallel clips

To use a green-screen clip,

import it, then import a background clip.
Drag the background clip onto the Video

1track in the timeline. Now place the
green-screen clip onto Video 2 so it
runs parallel to the background clip.

B o B im T Fi%

Image rights: Adobe.
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Fine-tune key
The green-screen transparency
may vary due to shadows. Toggle open
Matte Generation, then drag Tolerance
to the left to make more of the green

transparent. Drag Pedestal to the right
to hide remaining pixels.

| = .

Take a sample

Click on the “fx" icon, then go to
Keying. Drag the Ultra Key onto the
top green-screen clip, and click on the
eyedropper tool next to Key Color. Click
to sample the green backdrop. The
sampled color will turn transparent.

> GARBAGE MATTE

Hide objects in your green-screen composite

You might not have a large enough green screen to fill the frame. In our example,
we can see the curtain rail and part of a studio light at the top of the frame.

To make these non-green areas become transparent we need to create a
“matte”. From the Keying panel, drag a Four-Point Garbage Matte onto

the top clip. By increasing the values in the right-hand column of the Top

Left and Top Right points, we are able to move the top of the garbage matte
downwards so that the curtain rail becomes completely transparent at the top
of the frame.
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Manage website permissions

REQUIRES
Safari

YOU WILL LEARN
How to manage Safari's
preferences so that
websites work the way you
want them to

IT WILL TAKE
15 minutes

GENIUS TIP

Click Reader in the search
field to strip web articles of
ads, videos and surveys.
Ctrl-click and you can set it
to automatically appear

on all future visits.
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WEBSITES AREN'T ALWAYS fun.
Some insist on auto-playing
media. Others bombard you with
pop—up surveys. And many will
interrupt your reading with adverts. In a lot
of cases, websites will do all three (and
more), but the good news is you can start to
take control of websites by managing
preferences in Safari.

Apple’s web browser enables you to
determine whether you want to be sent
notifications, view videos, download
content, grant access to various functions of

Set Safari's preferences

# WATCH
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£ Find the settings

There are two ways of managing Safari's
Preferences. The first is to Ctrl-click the Smart
Search field and click “Settings for [website]". This
instantly displays the preferences that only affect
the website you're viewing.

your Mac, and see pop—up windows. For
even more control, you can nail a particular
preference to every website you visit or
create settings on a site—by-site basis. You
can also quickly manage all of the changes
you make.

Such versatility is complemented by
Reader — a quick—-fix mode that formats
web pages to make them easier to read by
handily removing distractions. Reader
doesn’t offer as many bespoke options as
Safari’s preferences, however, as you’re
about to see. DAVID CROOKES
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¢ Stop auto-playing

" You could, for example, manage auto-
playing media on a website. To do this, click
Auto-Play and use the menu to allow or stop the
function, or prevent media with sound.
Preferences are remembered for future visits.
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Apply to all websites

The second way to control Safari is handy
if you want to apply the setting to all websites. Go
to Safari > Settings > Websites, then click Auto-
Play and choose the option from the “When
visiting other websites” menu.

& Wppim.com

Tl ‘Whan vwaling appi.cem Al

Wee Reasar woen syanacly
I Erutile cortimmi bockn

#ngn Sove | 100%
Aun-Pay. Sop Muois wiin Guung
Bgi-tp Winnnew Beock and Rosify

carws

i L —
Emmen Snstingn Mew
Losaiong e

£ 40N

S——
LTl

Airfrlay

Set access options

Ctrl-clicking the Smart Search Field
doesn't offer as many options as steps 3 and 4,
but you can set page zooms or determine if a
website can access your camera, mic, location
and screen, or needs to ask each time.
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Manage notifications
Settings > Websites also enables you to
manage notifications. If a website has asked for
permission to show alerts, click Notifications and
you can change the status (Allow/Deny)
or uncheck a box to stop all websites from asking.

Image rights: Apple Inc.

How to do anything on your Mac, iPhone & iPad
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Manage pop-up windows

The same procedure applies for many
other settings and it works both ways. Want to
block pop-up windows across all websites yet
allow them for a few? Set the main preference to
Block and set the individual website to Allow.
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Make quick changes

Making a quick change is simple. When
you configure a website it's added to a list in
Settings > Websites. Just click a setting you want
to manage or make changes to, or select a
website and click Remove.
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Limit downloads

Play around and go through all options
in the left-hand pane. The Downloads options
enable you to Allow or Deny downloads from
currently open websites. Click the Content
Blockers options to manage ads.

JARGON BUSTER

Content blockers are apps
containing rules preventing
certain items from
appearing on a site. In
Safari > Safari Extensions,
search “content blocker”.

=

GENIUS TIP

To apply your website
preferences to all the Apple
devices you own, go to
Safari > Settings > Websites
and make sure that “Share
across devices” is ticked.
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Customize your Lock Screen

Make handy changes to your iPad'’s Lock Screen with iPadOS 17/

REQUIRES
iPad0S 17

YOU WILL LEARN
How to personalize one or
more Lock Screens on iPad

IT WILL TAKE
10 minutes

SINCE iOS 16, iPhone users have
been able to create multiple Lock
Screens featuring a host of
widgets drawn from a wide
number of first— and third—party apps. You
can also take your pick from a selection of
suggested wallpapers, alter the way the time
is displayed, see helpful information at a
glance, and play around with a variety of
color schemes. In other words, it allows for
greater personalization.
With iPadOS 17 this same functionality is
now available on iPad, and there’s plenty to

HOW TO Pick a new wallpaper

get stuck into. Want a Live Photo as your
Lock Screen and see it animate? Well, now
you can! Fancy a Lock Screen that reflects
the weather in your area? No problem, you
got it! You can even select an emoji and
replicate it across your display, or create
more than one Lock Screen for every
occasion you could think of, from work to
particular hobbies.

One thing’s for sure, Lock Screen creation
is heaps of fun and, thanks to the widgets,
it’s convenient, productive, and customized
to your preferences. DAVID CROOKES

Customize mode

To change the wallpaper on the
Lock Screen you currently have, go to
Settings > Wallpaper and tap Add New
Wallpaper. To start afresh, tap and hold
on the Lock Screen until you enter the
editing mode, then tap “+".
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Add new wallpaper

Either scroll down and view the
suggested and featured wallpapers, or
use the options at the top of the screen.
You can select images from your photo
library, create a photo shuffle of favorite
images, use emoji and more.

Make changes

Each wallpaper has its own
customization options. You may be able
to swipe left/right for more colors and
patterns, tap an icon (bottom right) to
switch between light and dark, or add
gradients to plain colors. Tap Add.

Image rights: Apple Inc



How to do anything on your Mac, iPhone & iPad

HOW TO Add a depth effect
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Tweak the color

You can also choose a different
color — one that will better complement
the background, perhaps. There are a
number of suggested options, but if you
select the multicolor icon you
can choose exactly what you want.

Use a depth effect
Before changing the look of the
time itself, let’s briefly cover Depth
Effect. This 3D effect can be turned on
and off via the “." icon when using a
photo as a wallpaper. It places part of an
image over the clock display.

Change the font

Tap the time and you can choose
a different font. Simply swipe left and
right to see the various typeface options
and use the slider to adjust the size.
You can tap the world icon to switch
to a different language too.

HOW TO Add Lock Screen widgets

]
=]

Add to the side

Widgets can be added in the

Start from the top

Widgets display at-a-glance info

Reorganize widgets
Widgets can also be dragged

and there's space for one at the very top
of the screen. By default, the top-most
widget displays the date. Tap it to add
Calendar, Weather, Reminders, Health,
Stocks or Clock widgets instead.

Image rights: Apple Inc.

sidebar. Just tap the area to see what's
available, either using the search field to
look for widgets, perusing the
suggestions or tapping the categories.

into position from the selection panel.
You can move widgets around in the
sidebar too. They come in various sizes,
but you may have to remove some to

make room for new ones.

Then tap the widget you want to add.

> USE FOCUS MODES

Control how you receive notifications

Once you have set up another Lock Screen, you can link it to a Focus mode
— a feature that lets you customize how and when you receive notifications
on your iPad. This ensures the Focus settings automatically activate when
a particular Lock Screen is being used, which is handy if you want to create
Lock Screens for different situations such as work and home, for example.
Just tap and hold on the Lock Screen to enter the customization mode,
then tap Focus on the Lock Screen you want to use before choosing the
Focus option.
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Master Smart Stacks

The redesigned watchOS 10 makes it much easier to see what matters

REQUIRES
watch0S 10

YOU WILL LEARN
How to organize

and customize

Smart Stacks

IT WILL TAKE
10 minutes

o
s

GENIUS TIP

Smart Stacks widgets show
more than just static
information. They can also
feature controls, for
example pause and resume
in Now Playing.
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THIS YEAR'S BIG Apple Watch
upgrade wasn’t hardware; it was
watchOS 10, which makes
compatible Apple Watches feel
like new. And one of our favorite new
features in this latest upgrade is Smart
Stacks. Like its iPhone equivalent, Smart
Stacks enables you to stack multiple app

widgets together for fast access to the
information you need most.

413" H:20°L13°
el R Sl | R o

Smart Stacks learn your schedule over time, automatically
organizing your widgets over the course of your day.

As you’ll see from our screenshots, Smart
Stacks look rather like the Siri watch face
we’ve already seen in watchOS. But not only
does it look better, it works better too.
That’s because over time, Smart Stacks
learns what your days are like — and once
it’s gleaned that, it can then customize the
Smart Stacks for different times of the day.
So, first thing in the morning, it may
prioritize the weather forecast and Music;
later on it might bring your workout-related
apps to the fore.

EASY TO CONTROL

To begin with, Smart Stacks only works with
Apple’s own apps, such as Activity, Weather,
Messages and so on. But third-party
developers can add their own widgets.

To make room for Smart Stacks, certain
elements have moved around a little in the
Apple Watch interface; swiping up no longer
reveals the Control Center’s various
buttons, because that’s now where the
Smart Stacks live. Now to bring up Control
Center you simply press the side button; it
works just like it did before and features the
same controls for Focus modes, Airplane
mode and so on. CARRIE MARSHALL



Sort your Smart Stacks

[T" See your Stacks

= To display Smart Stacks, either
swipe up from the bottom of your Apple
Watch's screen or rotate the Digital Crown
upwards. You should now see a display like
this, with the date and clock at the top and
widgets below.

f :T,‘E Swipe through

™ To move your Stacks, swipe your
finger upwards or downwards, or turn the
Digital Crown. The Stacks will move like a
vertical carousel, displaying the selection
of widgets such as your Calendar, the
Weather app and so on.

L iigg Hak

= See more info

" The widgets give at-a-glance
information; for more details, tap on an
app widget to open the corresponding
Apple Watch app. Here we've tapped on
the Weather widget to see when the best
time would be to walk the dog.

All Apps

€ Activity

Stack your Stacks
Smart Stacks organize the widgets
for you, and it gets better the more you
wear your Watch. Press and hold to select
a widget or widgets for the top of the
Stacks, then tap the yellow pin icon on

the appropriate widget to fix it.

07:51
Workout

Walking
1.7B KM

£ Set their style
i o As with existing Smart Stacks
apps. long-pressing on an app will display
the widget styles if there are multiple ones
available. You can then tap the widget you
want and watchQS 10 will automatically
add it to the Stack.

- Select your look
2 Some apps have multiple widgets
you can use in Smart Stacks. For example,
the Calendar app shown here has widgets
showing your schedule or just the day and
date in big letters. Press and hold a widget

to see its available styles.

. Erase an app

" You may not want all the standard
widgets, or you might decide you don't
want one after trying it out. To delete apps
from your Smart Stack, long-press, then
tap the red delete icon. This removes the
widget but doesn't uninstall the app.

) Add more apps

To add more apps to your Smart
Stacks, swipe up to display the Stacks, and
then press and hold the screen. You
should now see a large button with a “+" in
it; tap on that and you'll see the app
selection screen shown here.

HIF
i
|

e

+

Walking
1.78 KM

r.'x Erase the icons

" You can remove the panel of

shortcut icons for Music, Workouts and
Messages by scrolling to the bottom of
your Smart Stack and tapping the red “-"
icon — or you can move them to the top
of your Stack by tapping the pin icon.
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What's newon Apple TV

tvOS 17 brings some cool improvements — and Facelime too!

REQUIRES
Apple TV 4K or Apple
TV HD, tv0S 17

YOU WILL LEARN
All about some of the new
features in tv0S 17

IT WILL TAKE
10 minutes

UNLIKE MACOS, i0S and iPadOS,
".tv tvOS updates for the Apple TV

streaming box tend to be

stealthily incremental in
nature, and are often not noticeable at all.
This year’s update is different. For one,
tvOS 17 brings FaceTime to Apple TV 4K (2nd
or 3rd generation) by leveraging Continuity
Camera on iPhone and iPad, with support
coming for third—party apps such as Zoom
and Webex by Cisco too. Plus, Apple Music
Sing — which enables you to sing along to
your favorite tracks in karaoke fashion —

HOW TO Discover what's new in tvOS 17

Home Screen

changes

User Profile tweaks

The Home Screen now shows the

will also work with Continuity Camera too,
meaning no—one need miss out on the fun...
yikes! (Requires Apple TV 4K 3rd gen.)

Those of us who primarily use their Apple
TVs for, y’know, actually watching movies
and TV, will love the changes tvOS 17 brings
— these include Enhance Dialogue, which
leverages the power of HomePod to make it
easier to understand those Hollywood
mumblers. Plus, Dolby Vision 8.1 “brings a
more cinematic movie experience,”
according to Apple. Let’s look at some of the
key changes. ROB MEAD-GREEN

Control Center

More compact and iPhone-like

Your Apple TV's Home Screen now lets you
see more apps at a glance. This should
mean that you'll need to do less scrolling
with the Siri Remote or the remote on your
iPhone to find apps hidden from view.
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time, a user profile icon and more, in the
top-right corner. Long-pressing the TV
button on the Siri Remote expands that to
show the Control Center, which has been
completely redesigned.

than before, the new Control Center gives
quick and easy access to key features
such as Power Off and AirPlay. It may also
contain a Home app shortcut for

any smart devices you have connected.



Connect with AirPlay

To connect your Apple TV to one of
your AirPlay devices, select the AirPlay
button in Control Center to reveal a list of
those available. Scroll up or down using
the Siri Remote, then press the center
button on the remote to select one.

How to do anything on your Mac, iPhone & iPad

Set a Sleep Timer

If you're in the habit of nodding
off while watching TV, you can change
how long it'll be before your Apple TV
switches off. In Control Center, select
the Sleep Timer, then choose one of the

timed options from the drop-down menu.

Position iPhone Camera

Place your iPhone near the TV in landscape
orlentation with the rear camera facing you.

Do Not Disturb

To avoid being distracted while
watching your favorite show, select Do Not
Disturb from the Control Center. Once
you've finished watching, select it again to
switch it off — now you're ready to receive
FaceTime calls.

Let's FaceTimel

To use FaceTime on your Apple TV,
you'll need to connect it to a compatible
iPhone or iPad using Continuity Camera.
Start by selecting the FaceTime icon on
your Apple TV using the Siri Remote, then
select the user you wish to use.

Living Room Remote

now see a screen similar to this. You'll
need to have your iPhone oriPad’s rear
camera aimed towards you. On iPhone,
you'll need to use landscape orientation.
Tap Disconnect to end the connection.

) Position your iPhone

" On your iPhone or iPad, you should

£ FaceTime options

*"" During a FaceTime call, use the
icons at the bottom of the screen to
switch between three different modes.
Center Stage follows your movements,
Portrait blurs the background, Reactions
turns real-world gestures into effects.

£h) Find that remotel

S While it lacks the U1 chip, finding a
lost Siri Remote is easy with your iPhone.
On your phone, open Control Center. Tap
the Apple TV Remote, then the device list,
and tap Find. Now follow the visual
prompts on screen to locate the remote.

Image rights: Apple Inc

Smart home control

Tap the Home app icon in Control
Center and you'll be able to view any
HomeKit cameras you have connected.
Or if you have smart lights at home,
activate any lighting scenes you've
created — as shown here.

-3 New screen savers
* The Apple TV has always had some
great video screen savers showing
stunning locations around the world. With
those arriving on macOS Sonoma, two
more are coming soon: Monument Valley
in Arizona, and California redwoods.
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YOU WILL LEARN
How ANC and Adaptive
Audio can silence the
outside world

ANC IS A
DOUBLE WIN:
IT DELIVERS

BETTER AUDIO,
AND IT HELPS
PROTECT YOUR
HEARING TOO

KEY FACT

Anything you put in your
ears offers passive noise
cancellation by blocking
some of the sounds around
you — it's like closing a door
or sticking your head under
water. But this kind of noise
cancellation isn't very
effective and reduces the
volume of everything,
including sounds you might
still want to hear.
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WITHOUT A DOUBT, our favorite
I' )')) feature on the AirPods and

AirPods Max is the ability to turn

down noise coming from the
outside world. Whether it’s the chatter of a
busy cafe, the thrum of an airplane engine
or the rumble (and grumble) of a train full of
rush—hour commuters, AirPods, AirPods Pro
and AirPods Max make it easier for you
to listen to what you want by getting rid of
what you don’t want.

With the introduction of i0S 17, the most
recent models are turning noise canceling
up to 11. AirPods Pro 2 already had active
noise cancellation (ANC) but now that i0S 17
is here, they also gain a new feature called
Adaptive Audio. This monitors the audio
around you and lets you hear your chosen
sounds while blocking any noise that you
find distracting. It’s all very clever, but how
does it work?

There are two kinds of noise cancellation:
passive and active. Passive noise
cancellation is when you put your fingers in
your ears, use earplugs or have in—ear
headphones that fit very tightly: each of
those things effectively blocks a certain
amount of sound waves getting into your ear
canal. But the problem with passive noise
cancellation is that it doesn’t discriminate

ri*w 108 17 clever Adaptive Audio
.. ¥ ! feature-is only available in the

AirPods Pro 2; earlier AirPods don't
" -have the necessary processor.

between different sounds; it’s like an in—ear
bouncer banning every frequency from
coming in, including all the things you still
want to hear.

The other problem with passive noise
cancellation is that it doesn’t particularly
work very well. While it reduces sound, it
doesn’t remove it altogether, so your
earbuds or headphones still need to
overpower louder background noise. And
that often means turning up the volume of
your audio. However, that’s not very
efficient — low-frequency rumble from
things like buses and underground trains
can make the low frequencies in music
harder to hear, even when you turn
everything up — and more importantly, it’s
not good for your hearing health. As your
Apple Watch will happily tell you, there are
risks involved with long-term exposure to
overly loud sounds, and the damage this
does is irreversible.

Active noise cancellation (ANC) is much
smarter. It doesn’t just reduce the volume of
background noise, it removes it. And it can
do that without eliminating the sounds you
want to hear. That’s important because, as
mentioned, without ANC the only way to
drown out the outside world is to turn up the
volume. So ANC is a double win; it delivers a
better audio experience, and it helps protect
your hearing health too.



> AIRPODS AS HEARING HELPERS

Researchers at Taipei Veterans General
Hospital conducted an experiment that
involved 21 people, hearing aids, and
AirPods Pro/Pro 2. Each person had
mild to moderate hearing loss, and the
experiment sought to compare AirPods
against dedicated hearing aids. In all
but one scenario, AirPods with Live
Listen performed just as well as

WAVE HELLO, WAVE GOODBYE

Active noise cancellation is based on a
simple premise: because sound travels in
waves, to cancel it out you play the same
wave in reverse. This means every peak
becomes a trough and vice-versa, and the
opposites cancel each other out. The result?
Silence. However, delivering this is not as
simple as it sounds...

Active noise cancellation was developed
by engineers at Bose, when they were
creating headphones for the Voyager — a
powerful aircraft that was also incredibly
noisy to sit in. The headphones featured
microphones that listened to the sounds
around the wearer. This information was
then sent to a dedicated processor that
analyzed the noise, worked out what should
be removed, and created “antisound”
waves. These waves were then added to the
sound coming from the headphones.

WHY AIRPODS ARE SO SMART

Although the principles of active noise
cancellation haven’t changed — detect
sound, create antisound — the technology
that handles it gets better with each
generation, identifying what sounds we
want and what sounds we don’t want.

The tech also enables earbuds and
headphones to provide a Transparency
Mode. This selects some outside sounds and
plays them to you — sometimes for safety,
so you can hear a bus coming rather than
risk stepping out in front of it, for instance.
It’s also convenient, meaning you can
clearly hear transport announcements and
other sounds you really don’t want to miss.

In the latest generation of AirPods Pro,
the improved processing power also means
you get Adaptive Audio. And that’s the

Image rights: Apple Inc

standard hearing aids. They also
met four of the five criteria
required by the official ANSI/
CTA-2051 hearing aid standards. This
could be a very big deal, because, until
recently, the US regulated hearing aids
as medical devices, which kept their
prices high and meant only around
20% of the people who needed hearing

How to do anything on your Mac, iPhone & iPad

aids could afford them. Now, with

the Food and Drug Administration
(FDA) having established new rules,
you can buy hearing aids over the
counter. As a typical hearing aid costs
ten times the price of AirPods Pro, this
rule change should open the market to
all kinds of alternative providers, Apple,
Sony and Bose included.

Active Noise Cancellation in AirPods Pro and Pro 2 means you don't need to listen to your audio at
ear-damaging volumes, even when you're in a noisy environment.

smartest ANC we’ve ever heard. Adaptive
Audio, launched in iOS 17, is a blend of ANC
and Transparency Mode. It uses machine
learning to analyze the sounds around you
in a much smarter way, and can tell the
difference between the sounds when you’re
walking down a busy street and the sounds
inside a building. It can also tell when those
sounds change — so, if someone starts
digging up the road with heavy machinery,
for instance, your AirPods will notice and
then eliminate that extra noise.

The ANC and Adaptive Audio in iOS 17 can
also pick up the difference between the buzz
of a conversation around you compared with
somebody speaking directly to you. Along
with the Conversation Awareness feature
that uses the same processing, that means
AirPods will intelligently adjust what you
hear — boosting the sounds you need,
upping the volume of other people’s speech,
and reducing the ambient audio so you can
hear better. CARRIE MARSHALL

KEY FACT

Active Noise Cancellation
(ANC) improves your
listening experience by
reducing the need to turn
up your earbuds. With less
(or no) background noise to
compete with, you will be
able to focus on your
music, audiobook or
podcast without turning up
the volume to levels that
could potentially damage
your hearing.
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TECH SUPPORT & TECHSPLANATIONS

Software Update insecurity

JUST AS WE don’t all want
to drive automatic
vehicles, some of us prefer

to download and install updates
when we choose, rather than
leaving it to the Software Update
pane to decide. There are hidden
dangers in that; going fully
manual with all the pane’s

settings disabled can fail to detect
updates to macOS’s built-in
malware protection, leaving your
Mac at risk.

Unless you check for and install
those using other means, such as
the softwareupdate command or
the free app SilentKnight, every
Mac should run with the last item,

> Share certificates across Macs

How can | share security certificates in my iCloud Keychain?

EXPERT
ADVICE

Our resident genius
Howard Oakley solves
your Mac and i0S problems

and install security responses and
system files (or similar) enabled in
Software Update. That still gives
you control over whether and
when macOS updates are
downloaded and installed,

and should stop your Mac

being left with out-of-date
security protection.

Keypchain Access
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Keychain Access only sees passwords in the keychain shared in iCloud, and can't add other secrets like certificates.

You don’'t appear to be able to
share secrets of your own
choosing, apart from internet and
other passwords, using the

keychain shared in iCloud. That
isn't because of any limitation in
the keychain, but is due to the fact
that you can't add your own keys
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or certificates to the keychain
that's shared.

Macs have two types of
keychain. The login keychain, that's
normally used to store our own
certificates and secure notes, uses
an ancient format, is stored in our
Home Library's Keychains folder,
and can't be shared in iCloud. The
Keychain Access app has full
access to its contents, which
makes it simple to add certificates
and other secrets.

The iCloud Keychain uses a
different format with access
controls for better security, but
Keychain Access can only see its
passwords, not the rest of its
contents, preventing us from
adding our certificates so they can
be accessed by other Macs
and devices sharing that keychain.

Apple intends moving away from
the old file-based keychains like
login, and using “data protection”
replacements like the keychain
shared in iCloud. For now, the only
way to use those certificates on
multiple Macs is to add them to the
login keychain on each.

Image rights: Apple Inc.



SHARE WITH US!

EMAIL: ask@maclife.com
FACEBOOK: facebook.com/maclife TWITTER: twitter.com/maclife

Tech Support & Techsplanations

Mac|Lifes®

Get official documentation at support.apple.com | Get help with hardware at support.apple.com/repair

> Never share your Apple ID

My wife and | share an Apple ID, but | can’t use my profile photo for calls on
my iPhone, as it says two phone humbers are associated with one Apple ID?

Your Apple ID and iCloud account
are intended for one individual to
use, and shouldn't be shared with
anyone else, no matter how close
you are. Although Apple doesn’t try
to enforce that, it's explicitly
included in iCloud's terms and
conditions. You and your wife would
do much better to have your own
Apple IDs for separate iCloud
accounts, that can then be grouped
together with Family Sharing to
bring you the same benefits and
shared features, and your own
profile photos.

Apple explains how to tackle this
in https://apple.co/473IuCc. Setting
up a family group is straightforward:
you each need your own distinct
Apple IDs, and one of you becomes
the organizer of the group. The
organizer then opens their Apple ID
in Settings on their iPhone or iPad,
or System Settings on a Mac, and
opens Family Sharing there to set it
up and add each of the other Apple
IDs as family members.

You are then able to share your
iCloud+ storage (as explained at
https://apple.co/4091171),

Photo Libraries, and subscriptions to
Apple’s services including News+.
Having individual accounts ensures
that both your accounts are kept
secure, and that your iCloud access
is kept separate in the event that
you might ever need to have solo or
private access to contents

stored in iCloud.

Image rights: Apple Inc

< Settings

Family

E Howard N (Me)

Family Checklist

& 1Teme

Subscriptions

ibseriptio

Purchase Sharing
Enabled
Location Sharing

Add family members in Settings, and allocate shared subscriptions,
iCloud+ storage and other features.

Quick-fire
questions
& answers

WHICH BROWSERS
COULD IUSE
INSTEAD OF SAFARI?
There's now a wide
choice of third-party
web browsers to
choose from. These
include Firefox,
Microsoft Edge and
Google Chrome, and
more specialist apps like
Brave, DuckDuckGo,
Opera and high-privacy
options like Ulaa. Avoid
those whose titles start
with “Private Browser”,
or which aren't more
widely available.

HOW CAN MAPS TELL
WHERE I'M LIKELY
TO GO NEXT?

When enabled, your
iPhone or iPad keeps

a list of significant
locations that you visit
repeatedly, and shares
that with the Maps app
to suggest routes.
Enable this in Settings >
Privacy & Security >
Location Services >
System Services >
Significant Locations.

Significan Locatiors (

I35 Reconds
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Quick-fire
questions
& answers

SHOULD I SPLIT OR
REPLACE MY iMAC'S
FUSION DRIVE?

Ifit's over three years
old, it may not have
much life leftin either
the SSD or hard drive. If
you can afford it, have
the drive replaced with
an SSD, to extend its
working life for several
years. Otherwise, get

a Thunderbolt SSD
and start up from

that instead.

WHY CAN'TI
UPGRADE THE SSD
IN MY M2 MAC?

Most Apple silicon Macs
have their internal
storage soldered in, so it
can't be replaced
independently. Itisn'ta
normal SSD, but relies
on the M2 chip as its
disk controller, and its
Secure Enclave for data
encryption. It also
makes theft of your
Mac and its data
almost impossible.
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> Unlock a used Mac

Mac Hardware

We're here to help solve your hardware issues

I bought a used Mac mini 2018, but when I try to start it up, it asks for
a password or the Apple ID of its previous owner. How can | bypass
those, install a fresh copy of macOS and use it?

Unfortunately, only its previous owner can
open that Mac up, as it still has Activation Lock
enabled. This is linked to Find My Mac, and
prevents anyone else from starting up a Mac
protected by its T2 or Apple silicon chip. This
isn't a feature of older Intel Macs without a T2.
What the previous owner should have
done before parting with it is run Erase All
Content and Settings, which not only destroys
all their personal data kept on its internal
storage, but it also disables Find My Mac
and Activation Lock.
They can disable it in their account at
iCloud.com/find by removing that Mac from
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the list of All Devices there. However, if it

still has FileVault enabled, you'll need their
password before you can access its internal
SSD. With Activation Lock disabled, you could
restore that Mac in DFU mode from another
Mac, using Apple Configurator 2 (free from the
App Store), but that's not for the faint-hearted
and should only be a last resort.

If you're unable to get the Mac's previous
owner to help, but have proof of purchase, you
may be able to persuade Apple to unlock your
Mac, but be aware that this often happens
with stolen Macs, so you're going to require
good evidence that it's now legally yours.

Whairaan

Turn O

At the least, the previous owner has to disable Find My Mac before selling a Mac, or its purchaser will be locked out.

Image rights: Apple Inc.
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> Prepare your Mac for repair

What should | do to protect the personal data on
my iMac when it goes in for a screen repair?

(15 :'"":""f"_f___ 2

ﬂ L usii®, hide T O
hadil Wity i

Any repair to your Mac, even to the display,
could potentially require more extensive
surgery. To safeguard your data, ensure that
you back your Mac up thoroughly before it
goes anywhere.

If you've already enabled FileVault on its
internal storage, that will protect it from prying
eyes. If FileVault isn't yet enabled and your
Mac has a T2 or Apple silicon chip, then you
should turn it on, as the data is already
encrypted — so all FileVault has to do is protect
the key used for that encryption, which
happens instantly.

> Recover files in Target Disk Mode

My MacBook Pro 16-inch 2019 is sick and can't start up properly.
Is there any way to retrieve files from its internal SSD?

If FileVault isn't already turned on and your
Mac has an Intel processor but nota T2, it
could take many hours before it would provide
the protection of encryption. You might then
be better off removing or encrypting just your
most sensitive data.

Finally, remember to turn off Find My Mac
in the iCloud section of the Apple ID itemin
System Settings, and disable any firmware
password by starting in Recovery and using
Startup Security or Firmware Password Utility
there. If you don't disable those. the technician
may not be able to access your Mac.

Tech Support & Techsplanations

Quick-fire
questions
& answers

WHAT'S THE COSTTO
REPLACE A
MACBOOK PRO
BATTERY?

Apple should give you

a quote at https://
apple.co/46KRY4q for
around $249, using
original parts and
covered by its warranty.
Beware of others who
might fit inferior
replacements.

HOW TO CLEAN THE
KEYBOARD IN MY
MACBOOK AIR?
Remove any dust using
a vacuum cleaner with
care, and clean off solid
residue using a little
isopropyl alcohol and a
lint-free cloth. Although
you can use its Lock
Screen to stop this from
generating keypresses,
the best solution is the
free KeyboardCleanTool
from bit.ly/3Fsewef.

e

If possible, try using Target Disk Mode
with another Mac. To do this, your sick
Mac needs to be able to start up in this
mode; depending on what part of its
hardware is sick, that may not be
possible. Start it up with the “T" key
held until you see the Thunderbolt
symbol appear on its display. If that
doesn’t work, press the Power button
to shut it down again.

Image rights: Apple Inc

If this does work, connect it using a
Thunderbolt 3 or 4 cable to another
Mac; if it's running Catalina or earlier,
you should be able to use a USB-C data
cable if you don't have a Thunderbolt
one. Shortly after connecting the other
Mac, the Target's internal Data volume
should mount in that Mac's Finder, and
you'll then be prompted to enter its
FileVault password (if enabled).

S

When you've finished rescuing files
from it, eject the Target Mac's disk in
the Finder, then press and hold the
Power button on the sick Mac to shut it
down again. If you can't get this to
work and still need files rescued, ask an
Authorized Apple Service Provider or
Apple technician; they have a tool they
can use that could still work, although
some seem reluctant to use it.
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Q Ask

®

mac0S

Shine a spotlight on the solutions to
your most irritating Mac problems

> |gnore any permission problems

I moved my image library and documents to my new Mac on an external drive, but when | try to
use them | seem to hit permission problems. Why, and what can | do about it?

When inspecting permissions in the
Finder's Get Info dialog, each item has
an owner and group, with their set
permissions, and for all users. Although
shown there with names like your user
name, thatisn't how the file system
sees them: instead, owners and groups
are converted into numbers. On most
Macs, the first admin user is given the
number 501, and subsequent users
have numbers upwards of 502.
Sometimes users are removed, and it
can happen that an external disk ends

up with user numbers that differ from
those in that Mac. If a file is then owned
by user 505, but there’s no user with
that number, that can throw the
permissions system.

Thankfully, macOS provides a
workaround intended for external
drives. Select that drive or volume in

the Finder and open the Get Info dialog.

In the lowest section, Sharing &
Permissions, click the padlock and
authenticate with your admin
password. The bottom line offers the

> Lock private data away

How can | secure personal data on an external drive,
in case it gets lost or stolen? Could | use permissions?

Permissions don’t provide privacy
protection, and only limit access
for apps that behave themselves.

The only trustworthy way to prevent
access to personal data is to encrypt it
using a robust method such as APFS
encrypted volumes, or encrypted disk
images. Because all APFS volumes in a
container share its free disk space, it's

easy to add an APFS encrypted
volume to your external drive.

In Disk Utility, set the View tool to
Show All Devices, then select the

container on your external disk in the

sidebar. Click the “+" to add a new
volume, select “APFS (Encrypted)”
as its format, give it an unguessable
password, and an appropriate name
before clicking the Add button.
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checkbox to “Ignore ownership on this
volume”. Tick that and your weird
permission problems should vanish, as
macO0S then won’t worry whether the
owner is 501 or 505.

First select the container on the
disk where you want to add the
encrypted volume. This will share
space with the existing volume.

Select APFS (Encrypted), which prompts
you for a new password, then give the
new volume an appropriate name.

Image rights: Apple Inc.
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GetFileInfo command in Terminal:

> Find the file causing an error

When running First Aid in Disk Utility, | am warned that a “Resource Fork
xattr is missing for compressed file”, but the message gives an inode id
and doesn't tell me which file is at fault. How can | stop those errors?

Warnings like that aren't uncommon, and
generally clear themselves over time. If it
recurs, then you first need to identify the file
that's responsible. Inode numbers uniquely
identify every itemin a volume, and can be
used in an alternative low-level file system
known as volfs. Because the inode number is
only unique within that volume, to discover
which file it is you also need to know the
number of that volume.

One easy way to do this is using another file
on the same volume. Open that in the
free utility Precize from bit.ly/3FsnYhw, and in
its second line it gives its volfs path. Next open
Terminal and type:

GetFilelnfo

with a trailing space. Then copy the volfs path
from Precize and paste it into the command
line after that space. Delete the last number,
which is the inode of the wrong file, and paste
in the inode number given in Disk Utility’s
warning message, to create that item’s path in
a command like:

GetFilelnfo /.vol/16777238/402194151

Press Return, and a few seconds later Terminal
gives the full path to that file or folder, together
with other information about it. You can then

work out whether you want to delete that item.

Tech Support & Techsplanations

Mac|Lifes®

Quick-fire
questions
& answers

HOW OFTEN SHOULD
MACOS CHECK
ITSELF FOR
MALWARE?

In macOS Catalina

or later, XProtect scans
for malware should

run daily, or more
frequently when Apple
considers the threat is
high. Scans should run
in the background when
your Mac is awake but
not being used heavily.

HOW TO REMOVE
APPS FROM THE
OPEN WITH MENU?
Launch Services builds
that menu from the
apps on your Mac, and
which types of
document they can
open. An app that's
stored outside the main
Applications folders
won't normally be
included, but to be
certain, put the app in
an archive or remove

it altogether.

WHY DOES DRAGGING A FILE

TOiCLOUD MOVE IT THERE?

Dragging a file within the same volume moves
it, but between two different volumes it's
copied to preserve the original. Volumes
connected via a network are considered to be
separate, but iCloud is different, and an
integrated part of your Mac's Data volume. To

copy instead of move, use Opt-drag.

Image rights: Apple Inc.

WHY DOES TERMINAL TELL

ME IT HAS BEEN RESTORED?

When you open Terminal, any open windows
are returned to their previous status by
restoring that session, including any saved
window contents, command history and
environment. A new window instead gives the
time and date of the last login, when you last
opened Terminal, as it has nothing to restore.
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IPADOS 17

TIPS, TRICKS
& SECRETS

We delve into the latest version of
iPadOS and its raft of new features

WRITTEN BY IAN OSBORNE

HE iPAD’S OPERATING

system, iPad0S, had a

welcome upgrade this fall,

butit’s not as radical an
overhaul as the iPhone’s or Mac's.
The tablet’s Lock Screen gained new
customization options, including
widgets, bringing it up to date with
the iPhone which gained these
features last year. The iPad gets a
Health app with iPad0S 17, and it’s
optimized for the larger screen,
allowing developers to better
display their data and make it
accessible for review.

The Messages app. which has long
been a favorite among iPad users,
has had an interface overhaul, giving
easier access to attachments such
as photos, stickers and more. You
can also now create Live Stickers by
lifting subjects from your photos.
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A new AutoFill feature, coming
later this year, makes working with
PDFs easier than ever. If you have a
form to fillin, iPadOS detects text
fields and lets you add names,
addresses and emails directly from
your Contacts app. You can
collaborate when annotating PDFs
stored in the Notes app too, and link
individual notes to make it easy to
find related content.

Like the Mac and iPhone, if you
make a FaceTime call and the other
person doesn’t pick up, you can
leave an audio or video message.
Safari gains the same Safari Profiles
feature as macOS Sonoma and i0S
17, Stage Manager is more flexible,
and there’s new Freeform tools and
autocorrect features too. Let’s take
alook at them all and discover how

to make the most of this new update.

A:B5pm Mon 2 Oct
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FaceTime
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Which
devices will
work with

iPadOS 17

To download and install
iPadOS 17, you need one
of the following iPads:

iPad Pro 12.9-inch (2nd gen or later)
iPad Pro 10.5-inch

iPad Pro 11-inch (1st gen or later)
iPad Air (3rd gen or later)

iPad (6th gen or later)

iPad mini (5th gen or later)

Image rights: Apple Inc. DEC 2023 | 51



e Feature

New Lock Screen

You can now customize it with widgets and more

PPLE SKEPTICS MIGHT argue Android
A users have had them for years, but we

welcome them anyway. Lock Screen
widgets come to the iPad with iPadOS 17, and they
add a whole new perspective on what you can see
and do on your tablet before you unlock it. By adding
widgets for apps such as Reminders, Calendar, the
World Clock and more, you can glean information at a
glance, and as these widgets are interactive, you can
(for example) tick off reminders, turn Home-
controlled lights on and off, or play and pause your
music, right there from the Lock Screen. Plus,
widgets displayed on your Home Screens are
interactive now too.

There are lots of widgets to choose from. Open
the Settings app on your iPad, and in the left-hand
sidebar, tap the Wallpaper option. Alternatively, tap
and hold the Lock Screen. Now you can choose a
new wallpaper for your Lock and/or Home Screens,
or use the Customize button on your current
wallpaper to modify the one you have already. From
there, tap the widgets bar on the left (landscape
mode only) and then add and remove widgets. From
this screen, you can also change the color and font
of your time, change today’s date above the clock to
a different widget, and using the icons in the
bottom-left corner, turn the depth effect on or off so
the clock can be partially covered by wallpaper
details. You can also select between Light or Dark
Mode, or change between them automatically.

Widgets are now interactive, whether they're found on your
Home Screen or your Lock Screen.

Also in Settings > Wallpaper, you can tap the
Customize button for your current Home Screen
wallpaper and change it to a solid color, use a
gradient, choose a photo from your Photos app for a
wallpaper and add a blur effect. If you use a Live
Photo for your wallpaper, an advanced machine-
learning model renders additional frames, giving you
a slow-motion effect that activates whenever you
wake your iPad. You might find them too busy for
everyday use, but they look absolutely gorgeous.

How to Personalize your Lock Screen

D

Customize

Tap and hold anywhere on
the Lock Screen, and then
tap Customize at the
bottom, to edit this screen
to suit your own
requirements and tastes.

7

Time & date

On the customization
screen, you can tap the time
to edit the font, color and
weight used for the
numbers. Tap the date to
change it to something else.

c]

Widgets

You can choose what
widgets appear on the Lock
Screen'’s sidebar. They're
interactive, so you can
operate them without
unlocking your iPad.

D

Astronomy

The astronomy wallpapers
have been overhauled for
iPad0S 17. They're optimized
for the big screen, and you
can choose your planet too.

-~

-‘}._-
ez
[ L

0 e
-
O
B

Customization screen

Tap and hold the Lock Screen to go
straight to its customization options.
Alternatively, in the Settings app tap the
Wallpaper option in the sidebar. You can
now choose new wallpaper or customize
your current one.
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Tweak the time

Choose to customize the Lock
Screen. Tap the current time and a window
pops up, allowing you to change its font,
weight, color and shade using sliders. Tap
the globe icon in the top-left corner for
non-standard numbers.

The date widget

If you want, you can tap today’s date
above the time and change it to a different
widget. Again a window pops up, from
which you can choose the weather,
forthcoming events, alarms, reminders,
stocks and more.

Image rights: Apple Inc.



Quick Look iPadOS 17 Lock Screen
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e
Finding widgets

In landscape mode, tap the Widgets
Sidebar on the left. The Widgets Picker
appears. Choose an app from the left-hand
sidebar to see its widgets, and swipe them
left and right for differing widgets from the
same app.

Add & remove widgets

Tap a widget in the Widget Picker to
add it to the sidebar. Widgets come in
various shapes and sizes; slide left and right
and choose one. To remove widgets, on this
customization screen, tap the minus icon in
its corner.
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6 Change wallpaper

To select your wallpaper, go to
Settings > Wallpaper and tap the "+ Add
New Wallpaper” button. Choose something
from the picker. Swipe between wallpapers
you've customized and added, and tap Set
as Current to choose one.
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e Feature

Messages, Stickers
& FaceTime

New communication upgrades include
some highly requested additions o Viows

New Memoji
stickers

iPadOS 17 brings us three new
Memoji stickers, namely Halo,
Peekaboo and Smirk. This brings the
total number of Memaoji stickers
available to 54. To use one of the new
stickers (or an older one) in
Messages, tap the plus icon next to
the text field and in the window that
pops up, tap Stickers. In the row at
the top of the stickers window, tap
the Memoji option. Your new stickers
are there, along with the rest

of the range.

d &

The new operating system
upgrade brings us three new
Memaji stickers to use in the
| Messages app and more.

id

last, it's herel In iPadOS 17 (and indeed

i0S 17), if you make a FaceTime call and
the other party doesn’t pick up, you can
leave a video or audio message so they know
what the call was about. It's easy to do. When
you make a video call and the other person
fails to answer, you get a screen saying
theyre unavailable, just like you always have
in FaceTime. But now there's a button
inviting you to record a video message.

Tap the Record Video button and
a countdown timer starts, after which the
video recording begins. You can stop the
countdown timer mid-flow by tapping the
circular Pause button. To resume a paused
video recording, tap the red Record button.
Once you've finished recording your video
message, tap the Send button to send it, or
tap Retake to re-record it. To save your
message to Photos, tap Save.

There are a few things to bear in mind. To
send a FaceTime Video Message, both you
and the person you're ringing must have
iPadOS 17 or i0S 17 installed. You can't leave
video messages with people running earlier
versions of i0S or iPadOS. Also, you can only
leave a video message if the person on the
other end lets their device stop ringing of its
own accord, as opposed to declining the call.
A FaceTime video message can be up to

I T'S BEEN A long time coming, but at

FaceTime gestures

If your iPad is new enough, you can
trigger some great effects by making
hand gestures in a video call. Not just in
FaceTime, but in almost any app
supporting the standard iPhone camera
APIs, including Microsoft Teams, Google
Meet and Zoom. While on a video call,
open the Control Center to find two
new buttons. Tap Video Effects and
make sure Reactions is on. Now you can
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trigger a thumbs up or down by
making that gesture with your hand,
a spray of hearts by making the
two-handed heart gesture, two
thumbs up for fireworks, two thumbs
down for rain and more. Look out

too for balloons produced by the
peace sign, confetti by two peace
signs, and a laser display by giving
double devil horns.
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FaceTime users can now leave a video message if
the person they call doesn’t answer. According to
Apple, it was one of their most-requested features.

three minutes long, and there’s no option
to record only audio after a failed video call,
so if you don't want to leave a video
message, you'll have to cover the camera
with your hand while you speak.

Note, too, that a bug in the first versions of
iPadOS 17 meant that video message
recording didn't work properly for everyone,
with the Send, Retake and Save options
missing. The problem was finally fixed in
iPad0s 17:1.

Another communication app that
gets some love in iPad0S 17 is Messages. The

A two-thumbs-up gesture gives an impressive
fireworks display in a video chat. It doesn't
even have to be on FaceTime either.




search facility has been improved by adding
search filters. You can now start a search
and add additional terms, narrowing the
results and making it easier to find what
you're looking for.

If you've not looked at a conversation for a
while, and a lot of messages have been sent
without you reading or replying to them (this
is most likely to happen in a group chat), an
up-pointing chevron appears in the chat
window. Tap it and you're taken straight to

How to Create Live Stickers

If you make a FaceTime video call and the other
person doesn't pick up, tap the Record Video
button to leave a video message.

the first message you haven't read, making it
easy to catch up. Replying to a specific
message is easier too. Swipe it to the right
and tap the curly arrow there. Audio
messages are now transcribed, so you can
read them on screen as well as tapping Play
to listen to them.

If you like using stickers in Messages,
you'll be glad to hear you can use your own
photos to create Live Stickers. Open a photo
and pick a subject within that photo; it could
be a face, a flower, or just about anything.
Tap and hold it and it's cut out for you to save
as a sticker. To use a sticker, tap the "+" sign
next to the Message app’s text field. A new
window appears, from where you can
choose an attachment, including stickers.

iPad0S 17: Tips, tricks & secrets

Inline
Location

Another feature that came to
Messages with iPad0S 17 is Inline
Location, which allows you to check
someone’s whereabouts directly
from the Messages app. In
Messages, tap the plus icon next to
the text field and then tap the
Location option. A pop-up window
allows you to send your own
current location to the person
you're messaging, and also to
request theirs. In the conversation,
tap their name at the top to see
where they are.
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In the Messages app, you can now share
your location with the person you're
chatting to, and ask for theirs too.

0 3 F p g '
1 Find a photo

On your iPad, open your Photos app.
Look for a subject in one of the
photographs that you'd like to use as a
sticker, then tap the photo in
question to open it. The subject can be
anything you like.

Image rights: Apple Inc.

Make a sticker

Tap and hold on the subject
contained in the photo you wish to use as a
live sticker. You will see the subject
shimmer when it is cut out successfully.
Lift your finger for an options bubble; tap
Add Sticker.

Your collection

The item you chose is now
added to your stickers collection.
A window appears showing your live
stickers. Tap and hold one for a bubble
that lets you rearrange your stickers,
delete it or add an effect.
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e Feature

PDFs, Notes & Freeform

iPadOS 17 lets you use PDFs in a new way, and Freeform gets extra tools

FEATURE COMING LATER in the
A year will make it much easier to

work with PDFs on your iPad.
AutoFill will identify and fill text fields in PDF
forms and allow you to quickly add details
such as names, addresses, and emails from
your Contacts app.

Using new machine-learning

models, iPadOS can quickly identify the
fields you're being asked to fillin on the
form, such as your name, address, email,
phone number and more. You can then use
AutoFill to enter the required information. It
even works on documents you scan
yourself using the iPad’s camera. If you
need to sign the document, you can add a
saved signature or make a new one with
your Apple Pencil.

The AutoFill button even lets you

reply to the person that sent you the form,

returning it filled in using the Mail app.
It's a really handy way of dealing with
PDF forms.
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On a FaceTime call, you can collaborate on a PDF
that's an attachment in a shared note.

Quick Look Using AutoFill in PDFs
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AutoFill button
Tap the AutoFill button to get
a pop-up window, from
which you can populate the
fields on your PDF with
details from Contacts.
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Text fields

Using machine learning,
iPad0S identifies areas on
the form where you're
expected to add text, and
makes them text fields.

D

Adding info

You can add information
gleaned from your Contacts
app to fill out the text fields,
inputting a name, address,
email and more.
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PDFs are often stored in the Notes app.
as attachments on individual notes.

The way these are handled has also
been upgraded. You can annotate a

PDF stored on a note by tapping to

open it, then sketch and write on it

with your Apple Pencil. If you're
collaborating on that note with another
person you can both annotate the
document, with notes and additions synced
in real time. As you work on the PDF, the
other person’s edits appear as they write
them. It even works with stickers and
images added to the PDF.

The new features really take working with
PDFs to the next level. Markup has never
been more powerful, and filling in forms is
no longer a chore.
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- New in the

Notes app

As well as inline PDFs, the Notes app has
gained a few new features in iPad0S 17.
You can now create links between notes.
For example, if you're visiting a new city,
you might make a note for your travel
information, and then add links to other
notes about the location’s amenities,
hotels, restaurants, and more.

Using the Format menu, you can format

a portion of text in your note as a block
quote, indenting it from the rest of the

text. Also using this menu, you can opt for

amonostyled format, which basically
turns it into plain text. If you'd rather
continue editing a note in Pages, you can
do so by tapping the Share icon and
choosing Open in Pages.
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In the Notes app, you can turn a paragraph of text
into a block quote, and import the contents — text,

images and formatting — into a Pages document.

How to Link notes together

$Pad0S 17: Tips, tricks & seerefs
= T
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The iPad’s Freeform app, a digital
collaborative feature that brings the
office whiteboard to online meetings,
gains a few new tools in iPad0S 17. The
watercolor brush, for example, lets you
illustrate with the distinctive pastel
colors offered by water-based paints. If
you need something more solid and
stylish, there’s also a fountain pen for
calligraphy. Other new drawing tools
include a variable-width pen and a ruler.
With iPadOS 17, you can take your
drawings to a whole new level.

The Freeform app’s shape
recognition feature works like that
offered by the Notes app. If you draw a
regular shape with your Apple Pencil,
such as a square, a circle or a triangle,

In iPad0S 17 and its sister
upgrades for iPhone and the Mac,
the Freeform app gains a series of
new features and tools.

as soon as you've finished it snaps into
a perfectly formed geometric version.
Your squares have perfectly straight
sides and all angles are exactly 90
degrees, for example, and your

circles look like they were drawn

with a compass instead of freehand
on the screen.

Look out too for a new feature called
Follow Along, that lets you follow a
collaborator, tracking them on the
whiteboard and watching as they make
changes. Just the thing if the person
speaking during a video or voice
conference is illustrating what they're
saying on the Freeform board. You can
follow their movements without having
to manually move the board.
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Add link

First of all, find and open the note on
which you want the link to appear. Here

we're linking notes about a Christmas trip to

the note we made about travel times. Tap
where you want the link, and tap Add Link
from the menu.

Image rights: Apple Inc.
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Choose destination

A window appears. Add a URL or a
note title. If adding a note, auto completion
makes it easy to find what you're looking
for. If you don't want to use the note's title
as link text, tap the switch and type in
your own link text.
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Move between notes

Add as many links as you like. You can
then open the note or URL directly from the
note to which you added the links. Just tap
on the link you made, and you're taken
straight there. It's a great, speedy way to
collate information.
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e Feature

Everything else

What more does the new iPadOS 17 have to offer?

IKE MACOS SONOMA and i0S 17,in
L iPadOS 17 you can summon Apple’s

digital personal assistant by saying
“Siri" instead of "Hey Siri". To choose, open
the Settings app and in the Siri & Search
section, tap Listen For. You can also invoke
Siri during a telephone or FaceTime call now.

You can check activity history in the

Home app. allowing you to see who has
used a smart door lock and when, for
example. Garage doors, contact sensors and
security systems are also covered. If you like
crosswords and subscribe to Apple News+,

Safari
Profiles

Safari has gained a new feature
across Apple’s product range. Using
Safari Profiles, you can
compartmentalize your browsing.
Create profiles for home, work,
school and more, with each profile
having a separate history, cookies,
website data, extensions, Tab Groups
and favorites.

To start a new profile, in the
Settings app tap Safariin the sidebar
and look for the Profiles section. To
switch between profiles, tap the
profile button in Safari, tap the
current profile at the foot of the
window that appears, then choose
another one.
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With Safari profiles, you can keep your browsing for

work and home separate. It's easy to set up new
profiles and switch between them.
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you can now do crossword puzzles in the
News app too.

Visual Lookup was introduced with
iPad0S 15, and lets you look up information
on subjects in photos you've taken. With
iPad0S 17, you can look up recipes based on
photos of food. At last, you can take a
picture of your restaurant meal without
being laughed at.

For the first time, you can share AirTags
with up to five family and friends. Everyone
in the group can then track an item’s
location and have the AirTag make a sound.
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Choose an area to download, then use
the map offline on your iPad.

Offline maps

In the Maps app, you can now
download maps to use offline. This
is great news for hikers or those
that like exploring remote areas,
where cellular coverage might be
patchy or even absent.

To download a map, in the Maps
app tap your picture or initials at
the top of the floating sidebar and
choose Offline Maps. Accept one of
the app’s suggestions or tap
Download New Map, then search
for the area you want to download.
You're shown the map. Use the
handles on the rectangle that
selects the area covered, then
tap Download.

In iPad0S 17, you can share AirTags
with up to five others, so several people
can keep track of its whereabouts.

Just the thing for tracking communal
property or having several adults keeping
tabs on a child. And that's not all...

Journal

The Journal app has been promised
for the iPhone “later this year”, and it
seems extremely likely to arrive on
the iPad as well. A cross between a
digital diary and a scrapbook,
Journal lets you keep a day-to-day
record with your notes augmented
by data gleaned from your device's
native apps.

Using on-device machine learning,
the Journal app offers personalized
suggestions of what to include,
which could be photographs you've
taken, music and podcasts you've
enjoyed, maps of places you visited,
and even workouts you carried out.
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The Journal app lets you write about your day, and
add material gleaned from a range of Apple’s and
third-party applications.
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iPad gets a Health app

_ It'sbeenalong-
@ awaited addition,
but with iPad0S 17,
the Health app
finally comes to iPad. Naturally, all
your information is synced with
your iPhone and Apple Watch, but the
tablet format gives you much more

space to review and analyze your
health data. The app has been
optimized for the large screen, and
third—-party developers have been
invited to optimize their own health
experiences too.

One area where the Health
app benefits significantly from the

Mom's average resting haart rate increased
ower the last 5 dayn

Fatigue and Headache

larger screen is when it comes to
viewing interactive charts. It's far
easier to delve into the details of your
health data and assess changes over
time when viewing on the iPad.
Information is synced securely with
your other Apple devices, so there are
No privacy issues.
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WHAT IS
AVAXHOME?




the biggest Internet portal,
providing you various content:
B brand new books, trending movies,
fresh magazines, hot games,

recent software, latest music releases.

Unlimited satisfaction one low price
Cheap constant access to piping hot media
Protect your downloadings from Big brother

Safer, than torrent-trackers

18 years of seamless operation and our users' satisfaction

All languages
Brand new content
One site

AvaxHome - Your End Place

We have everything for all of your needs. Just open https://avxlive.icu



e Feature

Autocorrect

Text input has also been enhanced
with the latest update, making it
much easier with both the
keyboard and dictation.
Autocorrect, powered by on-
device machine learning, is now
more accurate than ever. You can
roll back an incorrect
autocorrection by tapping the
underlined word, and Predictive
Text now offers predictions inline
as you type, and finishes entire
sentences as well as words. If a
predicted word or sentence offered
in the text field is correct, just tap
Space to accept the suggestion.
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Machine learning takes predictive and corrective text to a whole new level with the iPad0S 17 update.

Stage Manager

Assumingit's recent enough, you can
already connect youriPad to an
external display for extra screen space.
IniPad0S 17, this feature gets a boost.
The position and size of your windows is
more flexible. You can resize windows,
move them around the screen and
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place them wherever you want. If you're
in a video call or conference, you can
use your external display’s inbuilt
webcam instead of the one on your
iPad. This is really handy if you regularly
use your iPad alongside an Apple Studio
Display for video chatting.

Mental
health

If you wish to track your mental
health, a new feature found in the
Health app helps you record your
moods and reflect on your state of
mind. Open the Health app and tap
Mental Wellbeing in the side column.
Tap “Logging Your Emotions and
Moods", and you can add information
on how you feel right now and your
general mood throughout the day.
Over time, this builds into a detailed
overview on your mental health.
Also available is a mental health
questionnaire that assesses your
risk of suffering from anxiety
or depression.
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Mental health features in the iPad's new Health app
allow you to log your moods over time and reflect
on what might contribute to your emotions.
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HE APPLE WATCH'S 10th
birthday isn't until 2025 but
its operating system,
watchOS, is now in double
figures. Last year's watchOS 9 wasn'ta
big deal, but this year is different. In
fact, we think watchOS 10 is the
biggest Apple Watch upgrade in years.
watchOS 10 is designed to
improve the Apple Watch experience
in three key ways: health, fitness and
customization. In the first category,
you'll find new features to help with

Image rights: Apple Inc.

WRITTEN BY CARRIE MARSHALL

your mental health as well as your
physical health. In the fitness category
there are huge improvements for
cyclists, new features for hikers, and a
wealth of enhancements to the Fitness
app and the Fitness+ service. And, in
the customization category, you'll find
new faces, more in-app options and a
new feature, Smart Stack, that makes
your Apple Watch even more you.
Here's everything you need to
know about this significant
Apple Watch update.

Apple Watch Series 4
Apple Watch Series 5
Apple Watch Series 6
Apple Watch Series 7
Apple Watch Series 8
Apple Watch Series 9
Apple Watch Ultra
Apple Watch Ultra 2
Apple Watch SE
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What’s hot in watchOS 10

Time to tick these improvements off your wish list

New faces

This year's new Apple Watch faces are
Snoopy and Palette. The former,
featuring Charles Schulz’'s famous
cartoon dog, may well be the cutest
Apple Watch face yet — and Palette
may well be the prettiest.

Snoopy and his pal Woodstock play with the
watch hands, and motivate you during workouts.

Palette has a gorgeous color-shifting display,
and lots of customization options.

HETHER YOU'RE WEARING
an Apple Watch Series 4, an
Apple Watch SE or an Apple

Watch Ultra, watchOS 10 will make your
Apple Watch feel brand new. In addition to
the usual selection of new features,
watchOS 10 also changes the way your
Watch looks and works.

The first thing you'll notice is that it's
visually quite different. Apple’s own apps are
brighter and more glanceable, with a unified
design that's coherent, consistent and very
clear. The Control Center has been moved to
the side button to make space for a new
collection of widgets that Apple calls
Smart Stack, and there are two fun new
faces as well as lots of customizations
and complications.

SMART CONTROL

Smart Stack is more than just widgets.

It uses machine learning to try and work out
what information you'll want to see and
deliver it when you want to see it, so you'll
see different things based on the time of
day, your typical schedule, your location, and
even the weather. We're very impressed by it
so far, and by the way it also brings key
controls for the apps you're using — such as
your podcasts or workout controls.

There are big improvements to fitness
tracking and Fitness+, to the Maps app for
hikers, and to workout tracking for cyclists.
But one of the most interesting health
features is new: mental health. Apple is
building on its mindfulness features by
offering mood tracking and, shortly afteriOS
17 launches, by providing a journaling app

Introducing Smart Stack

When you swipe up from the bottom
of your Apple Watch or turn the
Digital Crown, you’ll see the new
Smart Stack feature (Control Center is
now in the side button). Smart Stack
looks a lot like the Siri watch face,
and it’s designed to bring you info
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in little glanceable widgets, just like
widgets do on iPhone, iPad and in
macOS Sonoma. You can choose
which widgets appear, and the stacks
will change based on the time of day,
your location, whether you’re
working out, and so on.

Valentina

Smart Stack uses machine learning to predict
what information you'll need and to deliver
it when and where you need it.

that could be a very powerful way to identify
the things, places and people that make
you happier.

That's not all. NameDrop enables you to
give someone your contact details by
bringing your Apple Watch next to their
iPhone, Maps now has the same offline
mapping as the iPhone app. and group
calls are now supported over FaceTime
Audio. You can even view FaceTime
video messages on your wrist. @

The big benefit of Smart Stack is
that it provides quick access to info
you might not want or need to have
as a complication (or because your
favorite face doesn’t have room for
enough complications): simply swipe
or turn and they’re there.

Image rights: Apple Inc.




In watchQOS 10

Clearer call alerts

Even the Ultra isn't big enough to
display a full Contact Poster like on iPhone,
but with watchOS 10 you get a call alert
that uses a photo to show who's calling. It's
a nice touch: we recognize faces faster
than we read names.

4/ 2 &

10:08

1 Stand

-

Attractive activities

The Activity app has been redesigned
to make all of your key info more
glanceable and swipeable, and it shares a
common design language with other apps
such as the Sleep app; everything feels
more cohesive.

5 10:09
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Serious sleeping

The Sleep app has had a makeover:
instead of showing your sleep schedule it
now takes you to your sleep data. The
schedule information is now accessed via
the alarm clock icon (top left). It still can’t
track your naps, though.

More weather

The Weather app is now super—
powered. Its background reflects current
weather conditions; the colored ring shows
expected temperatures, and integrates
with Smart Stack to show the forecast in
the morning.

Customize the Control Center

Swipe it up

Control Center now lives in the side
button, so press that to display it and then
swipe until you get to the bottom of the
icons. That's where you'll find the Edit
button, which enables you to adjust the
order or add and remove icons.

Image rights: Apple Inc.
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Tap to delete

Icons behave like they do on your
iPhone Home Screen when you go into edit
mode: tapping on the red “-" icon will
remove that app from Control Center. You
can't remove everything — features such
as Wi-Fi and Battery are fixed.

watchOS 10 masterclass

- 10:09
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Great outdoors

There are tons of improvements for
outdoor types, including new waypoint
features in Compass (pictured) and lots
of new metrics for cyclists to track their
rides. US Apple Watch users also get
new topographic mapping in Maps.

Everything is better

The World Clock app is a great
example of the redesign: while it shows the
same time, sun location, sunrise and
sunset details, it's much brighter, clearer
and friendly than before and devotes more
of its display to glanceable info.

Wolkje-Talkin  Water Lock
5 _ ®
() AA
> |

Add new icons

If you swipe past the current Control
Center icons, you'll see a second section
with green “+" icons instead. These are the
icons that aren't currently in Control
Center; add them by tapping on the “+" sign
and dragging to their new location.
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watchOS 10 introduces huge improvements to help you live a healthier, happier life

Power Zongs
Workout View

watchOS 10 contains a lot
of important upgrades for
cyclists, including the
ability to calculate
personalized power zones
from your activity and
from connected devices
such as cycle computers.
watchOS 10 can then
estimate your Functional
Threshold Power, which is
the highest average power
you can sustain for an
hour, and tell you what
power zone you’re in.

In addition to the color-
coded zone indicator

— ranging from blue for
easy to dark red for super
hard — the view shows
your elapsed time, your
time in the zone, your
cadence in RPM, and your
power output in watts.

5 10:09
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said "l really believe that if you zoom out to

the future and then look back and ask,
‘what has Apple’s greatest contribution been?’ it
will be in the health and wellness area.” And with
watchO0S 10, the already impressive Apple Watch
health and fitness features have now become
even better.

When it comes to exercise, your Apple Watch
does everything from cycle tracking to cyclist
training. And there are significant improvements to
the latter, including lots of new metrics to analyze
your rides and support for Bluetooth devices such
as cycling computers and power meters.

Hikers get some very useful new navigation and
emergency features, and all kinds of workouts

S PEAKING TO OUTSIDE magazine Tim Cook

Cycling metrics

on 1iPhone

(including third-party apps too) can take
advantage of Live Activities to show crucial data
on your iPhone without you having to unlock it.
Apple’s Fitness+ service has got some very
welcome improvements too, including the ability
to build a personalized Custom Plan, and all the
health and fitness apps have been given a visual
refresh to make them even more useful.

One important new feature is one you can't see.
There's a new Workouts API for app developers to
record workout data directly on your Watch instead
of to a paired phone, and that should enable them
to deliver more useful real-time data.

With watchOS 10 and iOS
17, your iPhone becomes a
bike computer. The phone
displays the same metrics
as your watch, but takes
advantage of the larger
display to make the speed
indicator much clearer
while showing the metrics
you want to focus on. The
display is customizable,

and it’s scrollable
to deliver more

information 23.4urn 128
when you want to

read it. That Stick your iPhone on the handlebars and
means your you've got a pretty great cycling computer
iPhone and Watch  with a customizable display.

cover the

essentials you’d already own one, you can

normally need a cycling
computer for — and if you

get its data on your
phone’s friendly interface.

Image rights: Apple Inc.



watch0S 10 masterclass

Apple Fitness, custom plans and Stacks

If you’re a subscriber to
Apple Fitness+ or have

it in your Apple One bundle,
you’ll like the advances in
watchOS 10. Following on
from the custom workouts
of watchOS 9, you can now
create custom Fitness plans
too. You can set a weekly
schedule, specify the
number of weeks you want
to do it and how much time

per day you want to spend,
and you can then select the
activity types you want to
include. You can add specific
workouts, trainers, and
even select the music.

The other new feature we
really like in Fitness is
Stacks. This is effectively a
fitness playlist, enabling
you to add multiple
workouts and/or

meditations to the same
stack and then move
seamlessly from one to
the other.

Not all features are
obvious. Watch apps get
new sensor information to
detect rapid changes in
direction and acceleration,
which should make golf,
tennis and badminton apps
even better.

Medication

Vision health

Daylight isn’t just good for your
mood. It’s good for your eyes too,
and the new Time In Daylight
feature in the Health app is
designed to ensure you get enough
of it. The International Myopia
Institute recommends children get
80 to 120 minutes outside each day
and adults at least 20 to reduce the
likelihood of near- or short-
sightedness, and your Watch can
automatically track your outside
time and tell you if you need to

get out more.

< Back Time In Daylight

o L L1

reminders

If you need to stay on top of a
medication or a food supplements
schedule, medication reminders are
genuinely life-enhancing and
potentially life-saving. In watchOS
10 they’re even better. You can now
get the app to give a follow-up
reminder if you haven’t logged your
medication, vitamin or supplement
at the usual time, and you can set
those reminders as critical for ones
you must not miss.

A revised Compass app has new
views including Elevation View
and Cellular Connectivity
Waypoints: if you go completely
off-grid, your Watch can tell you
the last place you were able to geta
phone signal, so you can retrace
your steps if you need to make or
take a call — a feature that’s
potentially very beneficial. US
users can also take advantage of
the new topographic hiking maps
and trail navigation discovery in
the Maps app.

Mental health

You can now log your
current or daily mood,

and that information goes
to a new part of your
iPhone’s Health app:
Mental Wellbeing. Apple
recommends you log your
mood twice daily to build
up a picture of your mental
health, but part of that
picture is still missing: the

Image rights: Apple Inc.

Journal’s mental health
features for ourselves, but
we’re definitely intrigued:
an app that with your
permission uses your
phone history (calls,
messages, photos,
workouts, location and
more) alongside mood
reporting could be a very
useful wellbeing tool.

new Journal app, which has
been designed to work
alongside the mood
tracking, activity tracking
and fitness apps to help
keep a record of your days
and suggest mentally
healthy things to do, was
due to arrive with iOS 17,
but is now “coming later
this year”. We’ve yet to try

The i0S 17 Journal app, which combines journaling, input
from multiple apps, and your own mood reporting, didn't
arrive in time for the watch0S 10 launch.

Journal

Manday Jun 5

Muorning visit, Dcean Beach
| dreamed about surfing last night.
Whenever thal happens, | Know I'm goin..

Thursday Jur 1
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There are two wired
inputs, but no Bluetooth
or digital features.

THE BOTTOM LINE

The lack of digital
inputs might deter
some, but the SP3
provides a compact,
high-quality set of
desktop speakers.
Compact and sturdy
Clear, detailed sound

£ Powerful 80W output

£ Only supports wired audio

GREAT mEmm
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Fiio SP3

Wired desktop speakers with powerful sound

$299.99 From www.fiio.com

Features Inputs - RCA, 3.5mm; frequency response - 65Hz - 20KHz

Dimensions 6.4 x 4.7 x 5.2in, 3.5 Ibs (each)

STEREO DESKTOP SPEAKERS have gone
slightly out of fashion in recent years, with
more and more people opting for one-piece
speakers such as the Apple HomePod instead.
However, there are still times when a good,
old-fashioned stereo system works a treat for
listening to music, a spot of gaming action, or
for creative work such as audio recording or
video editing.

Fiio's SP3 speakers are very much designed
for desktop use, but could also be used as part
of a wider home entertainment system,
providing a pair of compact speakers that
stand just 6.4" high, 4.7" wide, and 5.2" deep.
They'll sit neatly on either side of your monitor
without taking up too much space, but the 4.5-
foot power cable that links the two speakers
gives you plenty of room to experiment with
positioning in order to get the best sound.
They're solidly built, too, with an aluminum
casing that feels very firm and solid, and you
can either sit them flat on your desk or use the
removable stands to tilt them up at an angle of
seven degrees in order to disperse the sound
more widely.

WORKING IN TANDEM

Each speaker houses a 3.5-inch mid-woofer to
handle the bass and mid-range, as well as a
1.0-inch tweeter for higher frequencies, with
the two speakers together providing a very
healthy 80W output. The back panel of the
right-hand speaker houses all the controls,
with both stereo RCA (cable included) and
3.5mm inputs (cable not included) and an
Input button that lets you switch between
them. For the gaming crowd, there are glowing
lights built into the base of each speaker that
can cycle between a number of different

lighting effects — or just be turned off
altogether, if you prefer.

There are also separate controls for volume
and bass, but there's no remote control
provided, so having to reach behind the
speaker to adjust the controls might get a bit
irritating after a while. Arguably, the SP3
takes the “old-fashioned” approach a little too
seriously, as there are no digital inputs at all
— no Bluetooth, and no USB input either. You
could still use a DAC — a digital-to-analog
converter, such as Fiio’s own BTR7 — to provide
digital input from a Mac or iPad, but the lack of
digital features does seem like an odd omission
in our modern mobile world.

But if you don't mind that old-school
approach, the SP3 really delivers the goods on
sound quality. You're not going to get pile-
driver bass on compact speakers such as this,
but the SP3 delivers the catchy bass riff on
Queen's A Kind Of Magic with a firm, punchy
rhythm. The drums are tight and precise too,
while the Queen harmonies sound silky smooth
as they hum “magiiiiiic” in the background. And,
with the two speakers set as far apart as our
desk will allow, the SP3 picks each note out
clearly as Brian May's finger-picking arpeggios
bounce merrily from side to side — a stereo
effect that's completely lost on single speakers
like the HomePod. The SP3 packs a punch, too
— it's loud enough to annoy the neighbors at
around 60% of maximum volume, and will
certainly work well for audio recording or
video-editing work. It'll even handle a bit of
party music as well — although that's where
the lack of digital features might start to feel a
bit limiting, especially if you're streaming your
playlists from Apple Music or any other
streaming service. CLIFF JOSEPH



The SP3 provides a
compact but powerful
stereo speaker system
that's ideal for desktop use.

“IT'S LOUD ENOUGH TO ANNOY
THE NEIGHBORS AT AROUND
60% OF MAXIMUM VOLUME"
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The dock can supply up
to 96W of power to a
laptop while powering
USB devices.

THE BOTTOM LINE

With plenty of power
and more than
respectable speeds,
this dock will prove a
great companion for
any Mac.

Good selection of USB
Up to 135W total power
B2 Fast transfer speeds
£ Host port on front face

GREAT nmmm
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OWC 11-Port Thunderbolt Dock

A compact, fast Thunderbolt dock

$229.99 From www.owc.com

Features Create 3 independent daisy chains; 31.5" Thunderbolt cable included; 96W charging power
Needs Apple silicon M1 or M2 Mac, Intel Mac with Thunderbolt 3 (check site for detailed model support)

OWC'S LINEUP OF Thunderbolt docks continues
to grow with the 11-port model, which is a
little more compact and portable than some of
its siblings while still offering a good selection
of ins and outs. Shipping with a 135W external
power supply, it is able to provide up to 96W
directly to your laptop through its host
Thunderbolt 4 port, which also carries data.
Also on the front of the dock you’ll find a
3.5mm headphone jack, USB 2 port and an SD
card slot with up to 312MB/s transfer speeds.

The rear panel sports three further
downstream Thunderbolt 4 ports that can
supply 15W power each and have the same
40Gbps speed as the front port. Though
Thunderbolt 4 is only included with some of
the very latest Mac models, Thunderbolt 3
offers essentially the same theoretical speeds.
There’s no HDMI port on the dock, though you
can add an adapter if you wish. Also on the
rear are three USB 3.2 ports with up to 10Gbps
speed and a moderate 7.5W of power, which is
decent for connecting older devices.

OWC notes that it has designed the
architecture so that you can create three
“branches” on the Thunderbolt bus, meaning
you can remove daisy chained devices from
one chain without disrupting the others. It
also says you can connect multiple bus—
powered SSDs to the dock without sacrificing
performance, and indeed this worked well in
practice. Last but not least a Gigabit Ethernet
port is provided for networking at much higher
speeds than most Wi-Fi allows.

In testing the dock performed very well and
while Thunderbolt speeds were short of the
theoretical maximum — a known issue with
Macs for various technical reasons — they
were more than respectable, making editing
4K video from an external SSD while hooked
up to a second monitor a breeze. Connecting
multiple devices, some requiring power, was a
smooth experience, with the dock unobtrusive
on the desk. For most users, this dock will
prove a useful addition for expanding whatever
model of Mac you own. HOLLIN JONES



No Man's Sky

Tough testing, trusted ratings

A world of infinite exploration finally finds its way to Mac

$59.99 (on Steam) From https://hellogames.org

Needs macO0S 12.3 or later, 64-bit processor, 8GB RAM, 15GB storage space

.. PLAYING GAMES ON a Mac can be both
" ablessing and a curse. The Mac has
fewer titles than other formats,
and the games we do get are often
released years later. Take No Man’s
Sky. It was released with great fanfare on
Windows and the PlayStation 4 back in
2016. It’s since appeared on the PS5 and
Xbox Series X and S in 2020, and even the
Nintendo Switch in 2022. Yet it didn’t
appear on the Mac — a system that’s more
than capable of running it — until 2023.

Yet being this far behind has its
advantages. On its initial release, No Man’s
Sky was plagued with problems,
disappointing both critics and gamers.
Seven years on, the bugs have been fixed,
the features installed, and the game as a
whole polished and expanded.

The game takes place in a procedurally
generated, completely open universe. If you
can see it, you can go there. There are 18
quintillion planets to explore, but don’t try
to visit every one. That would take an
estimated 585 billion years.

Exploration and discovery are its key
themes. As you travel the universe, you
find new life forms, valuable minerals and
exotic flora and fauna, all of which you can
record as you go. Precious resources you
collect can be traded in for upgrades to your
equipment and your space ship.

A key feature is resource management. As you progress,
you learn to build new equipment using what you collect.

Image rights: Hello Games Ltd

S0, WAS IT WORTH THE WAIT?

To be honest, it’s mixed news. No Man’s Sky

clearly shows the danger of using
procedurally generated environments
instead of writing them by hand. It may
make for a potentially huge game, but it’s
often at the expense of depth. There may
be more planets to explore than you could
handle in a lifetime, but they frequently
feel way too alike. Similar gravity, similar

mineral deposits, similar plant life and wild

creatures that differ only aesthetically.

You can follow the game’s storyline, or
you can ignore it and just explore, treating
No Man’s Sky as a simulated life in space
rather than a game to be completed. The
storyline itself is thin, but living your best
life in space is satisfying.

No Man'’s Sky has been compared to Elite
and its sequels, but perhaps a better
comparison would be Animal Crossing. It
gives you a world to live in and enjoy, with
“completing” the game of secondary
importance. It’s something you may come
back to again and again if you enjoy it. Just
don’t believe the hype. IAN OSBORNE

Finding and logging new
creatures is an interesting
part of the game.

THE BOTTOM LINE

An interesting and
rewarding experience,
but only if you focus
on the journey instead
of the destination.

£ Huge amount to explore

B3 Visuals and acoustics
very good

& Weak storyline
& Planets can feel samey
GOOD mmmi
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You can easily adjust the
focal length when taking
photos in Portrait mode

— and even shift the focus
after shooting.

THE BOTTOM LINE

The iPhone 15 is
keenly priced and
has some neat new
features — that's

a win!

B Hey, Dynamic Island!
B Improved cameras
A6 is still plenty fast
£ Hobbled USB-C

GREAT nmmm
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The iPhone 15 has
finally dropped the
old model’s notch
in favor of the
Dynamic Island

— and it's much
better for it.

iPhone 15

How do we rate the
key upgrades?

From $799 From www.apple.com

Features 6.1-inch Super Retina XDR display
(2,556 x 1,179 pixels), A16 Bionic chip,
128/256/512GB of storage, Wi-Fi 6, Bluetooth 5.3,
5G, USB-C port, Dynamic Island

WHILE APPLE'S “PRO" iPhones always get the
best new features, those features eventually
“trickle down” to the rest of us — and that’s
the case with this year’s iPhone 15. Available
in four pastel shades (Blue, Green, Yellow and
Pink), plus Black, the iPhone 15 now sports the
A16 Bionic chip from last year’s iPhone 14 Pro
and gets its Dynamic Island too — the
animated area around the TrueDepth camera
on the front that’s used to display useful info,
notifications and more.

Interestingly, this year’s new iPhone also
has a much-improved dual camera system
with a 48MP Main camera for the first time,
plus a 2x Telephoto option. Like the iPhone 15
Pro, the iPhone 15 also gets a USB-C port

The iPhone 15's dual camera system can shoot at up to 48MP,
although Night and Flash photos are saved at 12MP.

instead of Lightning, although this time data
transfer speeds are limited to 480Mbps (USB
2.0), rather than the 10Gbps speeds of the
iPhone 15 Pro.

The iPhone 15 offers 128GB of storage for
$799, 256GB for $899 and 512GB for $1,099 —
although if you’re thinking of spending that
kind of money, you might want to consider an
iPhone 15 Pro with 256GB of storage as it costs
the same.

PERFORMANCE

As you’d expect from a phone that sports last
year’s “pro” chip, the iPhone 15 is no slouch
when it comes to performance . Apps launch
quickly and run smoothly, thanks to the A16
Bionic’s six—core CPU and five-core GPU, even
if it can’t quite scale the giddy heights of the
A17 Pro chip in the iPhone 15 Pro.

Of all the new features, the camera is the
thing that’ll be of most interest to new buyers,
but things here are a little complicated. That’s
because, in normal usage, the iPhone 15’s
Photonic Engine combines a 12MP low-light
image with a 48MP super-resolution one to
give you a more finely balanced 24MP result;
while the 2x Telephoto “lens” uses a bit of
photo trickery to cut a 48MP capture down to a
12MP one when you use the zoom. To capture a
full-res image at 48 MP, you’ll need to head to
Settings > Camera Formats and switch on
Resolution Control to use the HEIF Max setting
when using the Main camera at 1x.

Most interestingly, Portrait mode now
enables you to adjust the level of bokeh (blur)
when taking pictures of friends, pets or pot
plants by tapping the “f” icon in the top-right
corner, then swiping the focal length slider
above the shutter button left or right. You can
even change the focal length after shooting if
you want. Very cool, and very clever. Just like
the iPhone 15 itself. ROB MEAD-GREEN

Image rights: Apple Inc
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Improved adventure features
in watch0S 10 are easier to
read in sunlight thanks to
the brighter display.

The overall design of the
Apple Watch Ultra 2 remains
unchanged — aside from the
use of recycled titanium.

THE BOTTOM LINE

Pre-existing Ultra
owners look away, but
for everyone else the
best Apple Watch just
got even better.

£ Super bright display

S9 SiP enhancements

D Carbon neutral

B Needs longer battery life
for multi-day adventures

EXCELLENT nmmms

Image rights: Apple Inc

Apple ch
Ultra 2

A modest update — it's
still the ultimate Watch

From $799 From www.apple.com

Features 49mm case size, Apple S9 processor,
Always-0n Retina display, dust-resistant to IP6X,
water-resistant to 100m, dual-frequency GPS

THE APPLE WATCH Ultra 2 is still Apple’s
biggest and longest-lasting smartwatch,
targeting outdoor sports enthusiasts with a
rugged design and more advanced GPS tech
than the flagship Apple Watch Series 9. There
are few upgrades over the original Ultra, these
being a brighter display, a complication—
packed watch face, and a faster S9 processor.
The Ultra 2 still costs $799, with a choice of
Ultra-specific band, braided charging cable,
and Cellular support. Its also has the same flat
49mm display, protruding right-side button
array, and orange action button on the left.

SHINE BRIGHT LIKE AN ULTRA

The screen is brighter, up to 3,000 nits from
2,000 nits, a useful improvement in bright
outdoor conditions. A bigger design change is
the use of 95% recycled titanium, a major
improvement from the virgin material used in
the original. With the re-sourced Trail Loop
and Alpine Loop, two of the best Apple Watch
bands, the Apple Watch Ultra earns the carbon
neutral certificate.

The S9 SiP is a major upgrade. Apple claims
it’s 25% more efficient, built on 5.6 billion
transistors with 30% faster GPU animations
and 4-core neural engines that enable

Tough testing, trusted ratings

machine learning twice as fast. The processor
makes the bright display possible without
sacrificing battery life, and it also improves
the Siri experience. Siri computing now takes
place all on—device, resulting in faster
responses and some offline functionality. It
also enables the double-tap gesture. So, if
you’re hanging off a cliff, you could
theoretically answer calls and open apps by
tapping your index finger and thumb of your
watch hand together. Users can conveniently
double-tap to scroll through the Smart Stack,
control music playback, use the camera remote
app and more, too. And if you’ve misplaced
your phone, the upgraded ultra-wideband
(UWB) chip in the Apple Watch Ultra 2 can give
you directions to its location. Sadly, this only
works for those with an iPhone 15.

Even with a brighter display, the watch gets
36 hours of battery life with normal use. In low
power mode, it gets up to 72 hours of battery,
up from the 60 hours of the original. Still, this
falls quite short of the battery capabilities of
most other sports watches.

ADVENTURE UPGRADES

Thanks to watchOS 10, the Ultra 2 sees some
enhancements to its sporting credentials,
including the ability to connect to a range of
cycling sensors over Bluetooth to see your
power output, as well as mirrored workout
metrics on the watch. The built-in Depth app
gets an upgrade, too, with a record of all dives.

The Ultra 2 has the same compass app with
track-back features, but now it displays
current elevation in real time and shows
waypoints in a 3D view based on relative
elevation. For hiking workouts, there’s a more
detailed topographic map that flags points of
interest. Nearby trail information appears
upon starting a hike, providing insights on the
trail length, type, and difficulty.

In terms of safety, the compass app will
also detect two new waypoints: your Last
Cellular Connection (or last reception location)
and Last Emergency Call Waypoint, which will
lead you to a place where an emergency call
can be made on a carrier network. If you need
instant help, the Siren app rings an 86-decibel
alarm that can be heard up to 600 feet away.

Watch Ultra 2 makes enough incremental
upgrades to justify the $799 price. The future—
proofing enabled by the new S9 chip, added
convenience of the double-tap gesture, and
extra brightness make for a strong second-
generation attempt. KATE KOZUCH
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ESET Cyber Security 7

Security and anti-malware

$39.99 (Pro $49.99) per year From www.eset.com

Needs macOS 10.15-13

THREATS FROM
MALWARE, phishing,
and other online

crimes keep growing.

Although security protection
built into macOS has improved
greatly over the last couple of
years, you may feel that more is
required to keep on top of those
increasing risks. ESET Cyber
Security claims to provide
real-time protection against
malicious software, including
potentially unwanted programs
(PUPs) as well as real nasties,
together with protection from
phishing and other attacks over
the web and in email messages.
To be of any true value,
security software needs to
be complicated. ESET Cyber
Security consists of an app with
helpers and two system
extensions, one of which uses
the built-in Endpoint Security
system, while the other
monitors network connections

| b B e et |
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to protect web and email. Those
could make installation a
nightmare, but ESET’s staged
onboarding support turns it into
a series of steps negotiating
each obstacle put in place by
macOS, such as authorizing the
system extensions in Privacy &
Security settings and giving its
components Full Disk Access.

EXTRA PROTECTION

ESET’s presence is most
noticeable for the first few
minutes following startup,
when your Mac is already busy
maintaining its Spotlight
indexes and making its initial
backup. On a faster Apple
silicon Mac you’ll only notice
this if you follow CPU History in
Activity Monitor, but the app’s
process that scans files makes
significant use of Efficiency
cores. Overall, its protection
imposes remarkably little
overhead and remains
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All nine malware
samples were
detected and
removed promptly.

Installation guides
you gently through
its complications.
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unobtrusive throughout.
Automatic scans for malicious
software are made once a week,
although you can opt for a
custom schedule or run them on
demand whenever you wish.

Those can extend to your
whole Mac or target individual
folders or files. ESET Cyber
Security also monitors what’s
happening with your Mac’s
files. Try unzipping a
downloaded archive and it goes
straight in to check whether its
contents are malicious. This is a
significant difference from
macOS: although its XProtect
tools scan daily, Gatekeeper
checks are only run when you
try to open apps and files, not
when they’re just being saved.
If you want this more proactive
protection, you’ll need a product
like ESET Cyber Security.

USER FRIENDLY

It has extensive settings to
exclude items from its Detection
Engine, adjust its sensitivity,
and that of other protections.
You can also allow, block, and
exclude addresses from web
access. The app keeps its own
log records, covering any

Image rights: ESET, spol. s r.o.
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malware detections it has made,
filtered websites, the results of
its scans, and other events
including updates to the app
and its Detection Engine. Help
is online and consists of a
detailed guide to the software,
with access to ESET’s knowledge
base and to customer support.

MALWARE DESTROYER
ESET’s single license covers
both macOS and Windows 10,
while its Pro version extends to
cover Android phones and
tablets. In addition, the Pro
version adds a configurable
software firewall, removable
media blocking, parental
controls, more extensive
scanning of websites and
email, and monitors for
macOS updates.

To assess its performance
against known malware, we
pitched the Pro version of ESET
Cyber Security, using the same
scanning engine, against a
Ventura 13.4 virtual machine
packed with nine well-known
and recent types of malware,

supplied courtesy of the
Objective-See Foundation. To
ensure that macOS didn’t

provide any help, we disabled all

built-in security, including

Dwturtien Crmrn

Gatekeeper protection. Samples

used included CloudMensis,
DazzleSpy, Genieo, JokerSpy,
KeySteal, MacKeeper,
RustBucket, Shlayer, and
XCSSET. In every case, ESET
detected them as soon as they
were unzipped from their
encrypted archives and
removed all trace of them,
performing perfectly.

ESET Cyber Security is a
highly effective solution in the

Each feature
has options to
balance security
with intrusion.

For a higher cost,
the Pro version
brings even
more features.

EDITOR'S
CHOICE

battle against malware,
phishing, and other attacks over
the web and in email messages.
It delivers that with a small
footprint and without annoying
notifications — just quietly
getting on with its job. The
biggest question, though, is
whether you need to pay its
subscription, and that all
depends on your assessment of
risk and whether the protection
built into macOS is sufficient for
your needs. If you do decide that
you want enhancements, then
ESET Cyber Security or its Pro
version should be ideal.
HOWARD OAKLEY

THE BOTTOM LINE

Excellent enhancements to
security built into mac0OS
without hitting performance, if
you need them.

Early detection of malware
Low use of system resources
& Unobtrusive in normal use

Guided installation process
AWESOME inmnm
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Anker Soundcore Liberty 4 NC

Affordable wireless buds that pack a punch

$99.99 From https://us.soundcore.com

Features Adaptive noise canceling, 6 microphones, wireless charging case, sound
personalization, LDAC codec, 11mm drivers, IPX4 water-resistance

ANKER'S LATEST WIRELESS earbuds pack a lot
of functionality into a very affordable product.
Available in a choice of colors, there’s an
impressive ten hours of charge in the buds and
a total of 50 hours in the case, with a ten-
minute quick charge providing up to four
hours of playback.

Pairing is simple and along with the latest
Bluetooth 5.3 standard, you also get multipoint
connection so the buds will remember
multiple devices without having to be
re—paired. The Hear ID 2.0 system lets you
run tests to tailor the sound to your particular
tastes and store the settings; some will find
this useful, though we found the user—
customizable EQ a more satisfactory way to
get things sounding how we liked.

Six microphones power the adaptive active
noise canceling and there’s a good selection of
options here too, with five levels of canceling
up to 98%, two transparency modes and four
modes for different kinds of transport. Set to
the higher levels, the noise canceling system

74 | DEC 2023

does an excellent job of isolating you
from the outside world. Unlike Anker’s
other buds, this system adapts to both
your ears and the external environment
in real time. An Al system helps to
reduce background noise during voice
calls, with effective results. Plus, the
buds are lightweight, secure, and
comfortable to wear for long periods.
Most buds in this price range sacrifice
either battery life or decent noise
canceling, but the Liberty 4 NCs triumph
on both counts. It’s true that the plastic
case doesn’t have the same high-end
feel of a pricier metal one, but build
quality is still more than acceptable.
They also lack the spatial audio features
of some other models, but this is not
something many people will particularly
miss. With a pleasing sound, excellent
noise canceling, and class-leading
battery life, these earbuds are easy to
recommend. HOLLIN JONES

Up to 50 hours of charge in
the case means no more
battery anxiety.

THE BOTTOM LINE

Great-sounding and
fully featured wireless
earbuds at a very
attractive price.

3 Excellent battery life

B Effective ANC

£ Customizable sound

B Affordable pricing
AWESOME Bmmams



Under My Roof

Tough testing, trusted ratings

Catalog your belongings and morel!

Free (IAPs, $3.99/month, $24.99/year) From https://binaryformations.com
Needs macOS 11.1 or later, i0S/iPad0S 14.0 or later

: UNDER MY ROOF is a household
property database that’s free to
download, but limited to
indexing ten items. You can

remove this limitation with a yearly or

monthly subscription, and if you cancel you
can still access inventory you’ve already
added to the app. It’s available for the Mac,
iPad and iPhone, with your details syncing
over iCloud and a single subscription
covering the app on all platforms.

Index your household possessions,
recording information such as make,
model, price, condition, quantity, location
and more. You can add a photograph of the
item in question, and usefully, you can also
include pictures of the purchase receipt
and/or warranty information, and attach
documents such as electronic instruction
manuals. You can also index your house
itself, including details such as its purchase
date and price, square footage, the year it
was built and more. You can even record
routine maintenance and have the app
notify you when regular checks or repairs
are due. Under My Roof is nothing if not
comprehensive.

BUILD YOUR INVENTORY
It’s attractive too. Individual cards are clear
and well laid out, and can be sorted into
rooms if you wish. The interface is clear,
and when you buy new items (or if you still
have the box) you can bypass much of the
typing by simply scanning the barcode with
your iPhone. You can also use your mobile
device’s camera to scan paper documents
such as contracts and rental agreements.
As a functioning app, we’ve little here to
criticize at all. Maybe the search function
could be a little better tuned, but that
should improve over time.

We do have a couple of reservations
though. Firstly, the subscription model. As

Image rights: Binary Formations LLC.

a straight purchase it would be worth
$20-25 of anyone’s money, but do we want
to pay a monthly or yearly fee for a
database that we come back to far less
often after the initial population?

Also, are you going to have the discipline
to make the best use of it? We all have good
intentions, especially after moving house,
but building and maintaining an inventory
such as this takes time and patience. Are
you going to keep it up to date, adding new
products and purchases as soon as you
make them? Or is your enthusiasm likely to
whither before you’ve even finished
indexing your house, with the app falling
into disuse but still costing you a
subscription fee as you forget to cancel?

If Under My Roof sounds like the sort of
thing you’d find useful, and you’re
confident you can update it often enough to
make it worthwhile, you won’t be
disappointed. But if you’re not sure you can
go the distance with it, maybe subscribe for
a month or two and set a Calendar alert to
remind you to unsubscribe if it’s no longer
used. IAN OSBORNE

You can add a
comprehensive amount of
detail about your belongings.

THE BOTTOM LINE

A solid, attractive
app that might be
too much like hard
work to justify a
subscription.

B Excellent user interface

& Comprehensive
and detailed

Very Apple-like

2 Why the subscription
model?

GOOD mmm:
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@ Reviews
Best of the best

Can't find the hardware or app you're looking for in our reviews section? Then check in
here — we've highlighted the best in every major category, as voted for by us

> HARDWARE

T I S S 3 3
MESH ROUTER ASUS ZenWiFi XT9 asus.com $449.99  #201
4K USB-C MONITOR Ben( EW3280U beng.com $799.99  #169
THUNDERBOLT DOCK CalDigit Thunderbolt Station 4 caldigit.com $379.99  #199
KEYBOARD Cherry KW 9100 Slim for Mac cherry-world.com $59.99  #208
PORTABLE PRINTER Epson WorkForce WF-TI0W epson.com $299.99  #185
PORTABLE HDD Toshiba Canvio Flex 2TB storage.toshiba.com $79.99  #197
NAS DEVICE Asustor Flashstor 6 FS6706T NAS asustor.com $449 #210
WIRELESS CHARGER Belkin BoostCharge Pro Portable belkin.com $59.99  #197
DESKTOP SPEAKERS Creative Pebble Pro us.creative.com $59.99  #204
IN-EAR HEADPHONES Nothing Ear 2 us.nothing.tech $149 #209
SECURITY CAMERA EufyCam 2C (two-pack kit) eufylife.com $239.99 #IN
SMART SPEAKER Sonos Era 300 $0N0s.com $449 #212
OVER-EAR HEADPHONES Sony WH-1000XM5 sony.com $399.99  #197
AIRPLAY SOUNDBAR Sonos Beam S0N0S.COM Sk #187
WEBCAM AnkerWork B600 Video Bar ankerwork.com $219.99  #191
PHOTO PRINTER Liene 4x6 photo printer amazon.com $136.99  #190
PORTABLE BATTERY PACK Anker 533 us.anker.com $4999  #198
MOBILE DOCK Kensington 8-in-1USB-C Mabile Hub kensington.com $7755  #190
OFFICE CHAIR Branch Verve branchfurniture.com $549 #201
MOUSE Logitech MX Master 3S logitech.com $99.99  #198
ACTION CAMERA GoPro Hero 11 Black gopro.com $500 #202
DESKTOP MICROPHONE Cherry UM 9.0 Pro RGB cherry-world.com $139.99  #209
PORTABLE DAC iFi Go Blu ifi-audio.com $199 #189
PORTABLE SSD Crucial X8 crucial.com $219.99  #203
THUNDERBOLT 4 HUB Satechi Thunderbolt 4 Slim Hub satechi.net $199.99  #205
CD/DVD DRIVE NOLYTH External DVD Drive amazon.com $39.99  #204
TRAVEL CHARGER Mophie 3-in-1travel charger zagg.com $149.95  #202
iPHONE GAME CONTROLLER Razer Kishi v2 razer.com $99.99  #203
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>i0S/iPad0S APPS

T0 DO (PRODUCTIVITY) Things 3 culturedcode.com $9.99 #194
WRITING & Scrivener literatureandlatte.com $19.99 #138
EMAIL 3 spark sparkmailapp.com Free #190
PHOTO EDITOR W Pixelmator Photo 2 pixelmator.com $4.99 #193
VIDEO EDITOR 24 Final Cut Pro for iPad apple.com $4.99/month  #212
CAMERA @ Obscuras obscura.camera $9.99 #196
RSS READER P Reeder5 reeder.app $4.99 H176
DESKTOP PUBLISHING f) Affinity Publisher 2 affinity.serif.com $19.99 #206
NOTE-TAKING Notability 10 gingerlabs.com $8.99 #174
MIND-MAPPING W MindNode 7 mindnode.com $14.99 #184
DOCUMENT SCANNER == Genius Scan 6.0 thegrizzlylabs.com Free (IAPs) #182
CALENDAR £ Fantastical 3 flexibits.com $4.99/month  #198
FITNESS W Gentler Streak gentler.app Free (IAPs) #199
SHOPPING Grocery 3 smartgrocery.app Free #198
GRAPHICS Procreate for iPad procreate.art $9.99 #196
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T0 DO (PRODUCTIVITY) & Things 3 culturedcode.com $49.99 #194
WRITING & Scrivener literatureandlatte.com $49 #200
EMAIL 3 spark sparkmailapp.com Free #190
IMAGE EDITOR # Pixelmator Pro 3 pixelmator.com $49.99 #208
VIDEO EDITOR B Wondershare Filmora wondershare.com $109.99 #202
SCREEN CAPTURE 4 Screenflow 3 telestream.net $129.00 #164
MUSIC CREATION B LogicPro apple.com $199.99 #141
PASSWORD MANAGER (5) Secrets outercorner.com $19.99 #188
DESKTOP PUBLISHING Bl Adobe InDesign adobe.com $2099/month  #162
BACKUP (& Carbon Copy Cloner bombich.com $39.99 #136
VIRTUALIZATION BN Parallels Desktop 18 parallels.com From$99.99  #201
i ‘ SECURITY (@) ESET Cyber Security 7 eset.com $39.99/year #213
NOTE-TAKING /A Agenda agenda.com Free #204
AUDIO AND VIDEO CONVERTER @ Wondershare UniConverter wondershare.com $49.99/year #203
VIRTUAL PRIVATE NETWORK @& Nordven nordvpn.com $1.95/month #1868
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9% SECRETS OF
SONOMA

There's more to your Mac than meets the eye — find out what you're
missing with these secrets for the latest version of macOS

ALSO INSIDE...

The Ultimate
Christmas Gift Guid

High-tech treats for any Apple fan — or why not spoil yourself!

Make the most
of the TV app

Enjoy your favorite films and shows on your Mac,
iPhone and iPad — we show you how

..and much more!
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Led Zeppelin and Pink Floyd. It's the perfect guide to the albums you should own and love.
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